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วิชา  การใช้โปรแกรมคอมพิวเตอร์กราฟิก 

นายธงชัย  ชาบุดศรี 
 
 
 
 
 
 
 
 

วิทยาลัยเทคนิคชลบุรี 
สำนักงานคณะกรรมการการอาชีวศึกษา 



แผนจัดการเรียนรู้แบบบูรณาการ 
ชื่อรายวิชา  การใช้โปรแกรมคอมพิวเตอร์กราฟิก รหัสวิชา 21909-2019 

          จำนวน   2  หน่วยกิต จำนวนชั่วโมงรวม  72 ชั่วโมง 

--------------------------------------------------------------------------------------------------------------------- 
จุดประสงค์รายวิชาเพื่อให้ 

1. มีความรู้ความเข้าใจเกี่ยวกับการวิเคราะห์และจำแนกประเภทของสื่อสิ่งพิมพ์ 

2. มีความรู้ความเข้าใจเกี่ยวกับกระบวนการพิมพ์ 

3. มีทักษะในการออกแบบสื่อสิ่งพิมพ์และจัดองค์ประกอบศิลป์ในสื่อสิ่งพิมพ์ 

4. ผลิตสื่อสิ่งพิมพ์ด้วยโปรแกรมผลิตสื่อสิ่งพิมพ์ 

5. มีคุณธรรม จริยธรรม และค่านิยมท่ีดีในการใช้คอมพิวเตอร์ 

สมรรถนะรายวิชา 

1. แสดงความรู้เกี่ยวกับหลักการพ้ืนฐานของสื่อสิ่งพิมพ์ 

2. การออกแบบสื่อสิ่งพิมพ์ตามการใช้งาน 

3. ผลิตสื่อสิ่งพิมพ์ด้วยโปรแกรมผลิตสื่อสิ่งพิมพ์ 

คำอธิบายรายวิชา 

ศึกษาและปฏิบัติเกี่ยวกบความหมายและประเภทของสื่อสิ่งพิมพ์บทบาทของสื่อสิ่งพิมพ์ กระบวนการใช้

โปรแกรมคอมพิวเตอร์กราฟิกแบบ Desktop Publishing การจัดรูปแบบ การเลือกใช้ตัวอักษรการเลือกสี 

ประเภทของภาพและ 

การเลือกภาพประกอบสิ่งพิมพ์การผลิตและจัดหน้าสิ่งพิมพ์ด้วยโปรแกรมสําเร็จรูป 

 

 

 

 

 



สารบัญ 

เรื่อง          หน้า 

ตารางวิเคราะห์คำอธิบายรายวิชา        

ตารางวิเคราะห์การประเมินผลตามสภาพจริง      

แผนจัดการเรียนรู้         

กิจกรรมการเรียนรู้         

แผนจัดการเรียนรู้  เรื่อง  ความรู้พื้นฐานเกี่ยวกับสื่อสิ่งพิมพ์      

เฉลยแบบฝึกหัด หน่วยที่ 1  

แผนจัดการเรียนรู้  เรื่อง  หลักการออกแบบสื่อสิ่งพิมพ์      

เฉลยแบบฝึกหัด หน่วยที่ 2  

แผนจัดการเรียนรู้  เรื่อง  กระบวนการพิมพ์      

เฉลยแบบฝึกหัด หน่วยที่ 3  

แผนจัดการเรียนรู้  เรื่อง  รู้จักกับโปรแกรม Indesign CS6      

เฉลยแบบฝึกหัด หน่วยที่ 4        

แผนจัดการเรียนรู้  เรื่อง การจัดการไฟล์งานและเครื่องมือพื้นฐาน  

เฉลยแบบฝึกหัด หน่วยที่ 5        

แผนจัดการเรียนรู้  การทำงานกับข้อความ      

เฉลยแบบฝึกหัด หน่วยที่ 6         

แผนจัดการเรียนรู้  เรื่อง การปรับแต่งและจัดวางข้อความ     

เฉลยแบบฝึกหัด หน่วยที่ 7        

แผนจัดการเรียนรู้  เรื่อง การวาดวัตถุประกอบ  

เฉลยแบบฝึกหัด  หน่วยที่ 8        

แผนจัดการเรียนรู้  เรื่อง การใช้งานวัตถ ุ      

เฉลยแบบฝึกหัด  หน่วยที่ 9         

แผนจัดการเรียนรู้  เรื่อง ความรู้เรื่องสีและการใช้งานสี     

เฉลยแบบฝึกหัด  หน่วยที่ 10        



แผนจัดการเรียนรู้  เรื่อง เทคนิคการปรับแต่งภาพ     

เฉลยแบบฝึกหัด  หน่วยที่ 11        

     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ตารางวิเคราะห์คำอธิบายรายวิชา 

ชื่อวิชา  การใช้โปรแกรมคอมพิวเตอร์กราฟิก    รหัสวิชา 21909-2019     จำนวน    3  หน่วยกิต 
ระยะเวลาเรียน  18  สัปดาห์   จำนวน   4  ชั่วโมง / สัปดาห์   รวมจำนวน   72  ชั่วโมง 

 
ลำดับ

ที ่
ชื่อหน่วยการเรียนรู้ 

พฤติกรรมที่คาดหวังต่อการเรียนการสอน 1 ครั้ง 
ความรู้ ทักษะ จิตพิสัย รวม(ชม.) 

1. ความรู้พื้นฐานเกี่ยวกับสื่อสิ่งพิมพ์ 4 1 1 4 
2 หลักการออกแบบสื่อสิ่งพิมพ์ 4 1 1 8 
3 กระบวนการพิมพ์ 4 1 1 4 
4 รู้จักกับโปรแกรม Photoshop 1 4 1 4 
5 การจัดการไฟล์งานและเครื่องมือพื้นฐาน 1 4 1 4 
6 การทำงานกับข้อความ 1 4 1 8 
7 การปรับแต่งและจัดวางข้อความ 1 4 1 8 
8 การวาดวัตถุประกอบ 1 4 1 8 
9 การใช้งานวัตถุ 1 4 1 8 
10 ความรู้เรื่องสีและการใช้งานสี 1 4 1  8 
11 เทคนิคการปรับแต่งภาพ 1 4 1 8 

   13 การประเมินผลการเรียน  
รวม 72 

 
 
 
 
 
 
 

 

 

 



ตารางวิเคราะห์การประเมินผลตามสภาพจริง 

หน่วยที่ จุดประสงค์การเรียนรู้ เครื่องมือวัดผล คะแนน หมายเหตุ 

1.  ข้อสอบอัตนัย 2 จุดประสงค์การเรียนรู้ที่ไม่

ผ่านครูผู้สอนมอบหมาย

งานเพ่ิมเติมเพ่ือเป็นการ

พัฒนาความรู้และทบทวน

บทเรียนของผู้เรียน หาก

พบว่ายังไม่ผ่านจุดประสงค์

การเรียนรู้อีก จัดสอนซ่อม

เสริมให ้

2.  ข้อสอบอัตนัย 2 

3.  ข้อสอบอัตนัย 2 

4.  แบบประเมิน 2 

5.  แบบประเมิน 2 

6.  แบบประเมิน 2 

7.  แบบประเมิน 2 

8.  แบบประเมิน 2 

9.  แบบประเมิน 2 

10.  แบบประเมิน 2 

11.  แบบประเมิน 2 

12.  แบบประเมิน 2 

 

 

 

 



คู่มือครู  และ Course  Syllabus 
 

1.  รหัสวิชา  21909-2019    ชื่อวิชา      การใช้โปรแกรมคอมพิวเตอร์กราฟิก      ระดับชั้น ปวช. 
2.  ผู้สอน  นายธงชัย  ชาบุดศรี 
3. จุดประสงค์รายวิชาเพื่อให้ 

1. มีความรู้ความเข้าใจเกี่ยวกับการวิเคราะห์และจำแนกประเภทของสื่อสิ่งพิมพ์ 

2. มีความรู้ความเข้าใจเกี่ยวกับกระบวนการพิมพ์ 

3. มีทักษะในการออกแบบสื่อสิ่งพิมพ์และจัดองค์ประกอบศิลป์ในสื่อสิ่งพิมพ์ 

4. ผลิตสื่อสิ่งพิมพ์ด้วยโปรแกรมผลิตสื่อสิ่งพิมพ์ 

5. มีคุณธรรม จริยธรรม และค่านิยมท่ีดีในการใช้คอมพิวเตอร์ 

4. สมรรถนะรายวิชา 

1. แสดงความรู้เกี่ยวกับหลักการพ้ืนฐานของสื่อสิ่งพิมพ์ 

2. การออกแบบสื่อสิ่งพิมพ์ตามการใช้งาน 

3. ผลิตสื่อสิ่งพิมพ์ด้วยโปรแกรมผลิตสื่อสิ่งพิมพ์ 

5. คำอธิบายรายวิชา 

ศึกษาและปฏิบัติเกี่ยวกับความรู้พ้ืนฐานของสื่อสิ่งพิมพ์ กระบวนการพิมพ์ การออกแบบสื่อ 

สิ่งพิมพ์ เทคนิคการใช้ภาพถ่ายในสื่อสิ่งพิมพ์ และการใช้โปรแกรมผลิตสื่อสิ่งพิมพ์ 

 
 
 
 
 
 
 
 
 
 
 



6.  แผนจัดการเรียนรู้ 
สัปดาห์

ที ่
หน่วยการเรียนรู้/เนื้อหา กิจกรรม 

1 บทที่ 1 ความรู้พ้ืนฐานเกี่ยวกับสื่อสิ่งพิมพ์ 
1. ประวัติการพิมพ์ทั้งในและต่างประเทศ 
2.กระบวนการพิมพ์แบบดั้งเดิมและการพิมพ์ร่วมสมัย 
3. ประเภทของสื่อสิ่งพิมพ์  
4. องค์ประกอบของสื่อสิ่งพิมพ์ 
5. หน้าที่ของสื่อสิ่งพิมพ์  
6. บทบาทของสื่อสิ่งพิมพ์ 

 

ให้นักศึกษาค้นคว้าหน่วยการเรียน 
บรรยาย  
อธิบาย ยกตัวอย่าง  
แสดงวิธีการปฏิบัติในแต่ ละหัวข้อ
การเรียนและให้นักศึกษาปฏิบัติไป
พร้อมกัน 
สรุปบทเรียน 
แบบฝึกหัด / ทดสอบ 

2-3 บทที่ 2 หลักการออกแบบสื่อสิ่งพิมพ์ 
1. องค์ประกอบการออกแบบ 
2. หลักการออกแบบ 
3. การออกแบบหนังสือพิมพ์ 
4. ต้นฉบับงานพิมพ์ 
5. เทคโนโลยีเตรียมต้นฉบับงานพิมพ์ 

 

ให้นักศึกษาค้นคว้าหน่วยการเรียน 
บรรยาย  
อธิบาย ยกตัวอย่าง  
แสดงวิธีการปฏิบัติในแต่ ละหัวข้อ
การเรียนและให้นักศึกษาปฏิบัติไป
พร้อมกัน 
สรุปบทเรียน 
แบบฝึกหัด / ทดสอบ 

4 บทที่ 3 กระบวนการพิมพ์ 
1. การเตรียมต้นฉบับก่อนการพิมพ์ 
2. ตัวพิมพ์ 
3. พ้ืนฐานทางสี 
4. การแยกสี 
5. ระบบการพิมพ์ 
6. หมึกพิมพ์ 
7. กระดาษ 
8. การทำให้แล้วเสร็จ 

ให้นักศึกษาค้นคว้าหน่วยการเรียน 
บรรยาย  
อธิบาย ยกตัวอย่าง  
แสดงวิธีการปฏิบัติในแต่ ละหัวข้อ
การเรียนและให้นักศึกษาปฏิบัติไป
พร้อมกัน 
สรุปบทเรียน 
แบบฝึกหัด / ทดสอบ 

5 บทที่ 4 รู้จักกับโปรแกรม Indesign CS6 
1. รู้และเข้าใจในโปรแกรม Adobe photoshop 

- ให้นักศึกษาค้นคว้าประจำหน่วย
การเรียน 



2. อธิบายการเข้าสู่โปรแกรม Adobe photoshop ได้ 
3. อธิบายเกี่ยวกับแถบคำสั่งของโปรแกรม Adobe 

photoshop ได้ 
4. อธิบายเกี่ยวกับกล่องเครื่องมือของโปรแกรม 

Adobe photoshop ได้ 
5. อธิบายเกี่ยวกับคอนโทรลพาเนลของโปรแกรม 

Adobe photoshop ได้ 
6. อธิบายเกี่ยวกับพาเนลควบคุมการทำงานได้ 
7. สามารถจัดการกับหน้าต่างการทำงานได้ 
8. สามารถกำหนดคีย์ลัดได้ 
9. อธิบายเกี่ยวกับโปรแกรมช่วยจัดการข้อความ

ภาษาไทยได้ 

- แบ่งกลุ่มให้ไปศึกษา 
- บรรยาย 
- แสดงวิธีทำและยกตัวอย่าง 
- ให้นักศึกษาแสดงวิธีทำ 
- สรุปบทเรียน 
- แบบฝึกหัด/ทดสอบ 

6 บทที ่5 การจัดการไฟล์งานและเครื่องมือพ้ืนฐาน 
1. รู้และเข้าใจในโปรแกรม Adobe photoshop 
2. อธิบายการเข้าสู่โปรแกรม Adobe photoshop ได้ 
3. อธิบายเกี่ยวกับแถบคำสั่งของโปรแกรม Adobe 

photoshop ได้ 
4. อธิบายเกี่ยวกับกล่องเครื่องมือของโปรแกรม 

Adobe photoshop ได้ 
5. อธิบายเกี่ยวกับคอนโทรลพาเนลของโปรแกรม 

Adobe photoshop ได้ 
6. อธิบายเกี่ยวกับพาเนลควบคุมการทำงานได้ 
7. สามารถจัดการกับหน้าต่างการทำงานได้ 
8. สามารถกำหนดคีย์ลัดได้ 
9. อธิบายเกี่ยวกับโปรแกรมช่วยจัดการข้อความ

ภาษาไทยได้ 
 

- ให้นักศึกษาค้นคว้าประจำหน่วย
การเรียน 

- แบ่งกลุ่มให้ไปศึกษา 
- บรรยาย 
- แสดงวิธีทำและยกตัวอย่าง 
- ให้นักศึกษาแสดงวิธีทำ 
- สรุปบทเรียน 
- แบบฝึกหัด/ทดสอบ 

7-8 บทที่ 6  การทำงานกับข้อความ 
1. อธิบายการสร้างข้อความประเภทต่างๆ ได้ 
2. บอกเกี่ยวกับการปรับแต่งข้อความแบบ Type on 

- ให้นักศึกษาค้นคว้าประจำหน่วย
การเรียน 

- แบ่งกลุ่มให้ไปศึกษา 



Path ได ้
3. รู้จักเกี่ยวกับข้อความใน Adobe photoshop 
4. สามารถคัดลอกข้อความจากไฟล์โปรแกรมอ่ืนๆ 
มาใช้งานได้ 
5. อธิบายการไหลของข้อความได้ 
6. อธิบายเกี่ยวกับการใช้คอลัมน์ได้ 
7. สามารถตัดและรวมข้อความได้ 
8. สามารถแก้ไขข้อความในพ้ืนที่ Story Editor ได ้

- บรรยาย 
- แสดงวิธีทำและยกตัวอย่าง 
- ให้นักศึกษาแสดงวิธีทำ  
- สรุปบทเรียน 
- แบบฝึกหัด/ทดสอบ 

9-10 บทที่ 7 การปรับแต่งและจัดวางข้อความ 
1. สามารถปรับแต่งอักษรจากพาเนล Charactor ได ้
2. อธิบายการปรับแต่งอักษรจาก Control Panel ได ้
3. บอกวิธีการจัดเรียงข้อความได้ 
4. อธิบายการขึ้นต้นย่อหน้าด้วตัวอักษรขนาดใหญ่ได้ 
5. รู้จักเกี่ยวกับสไตล์ข้อความ 
6. สามารถการเปลี่ยนสีข้อความได้ 
7. อธิบายการนับคำในข้อความได้ 

- ให้นักศึกษาค้นคว้าประจำหน่วย
การเรียน 

- บรรยาย 
- แสดงวิธีทำและยกตัวอย่าง 
- ให้นักศึกษาแสดงวิธีทำ 
- สรุปบทเรียน 
- แบบฝึกหัด/ทดสอบ 
- สรุปบทเรียน 
- แบบฝักหัด / ทดสอบ 

11-12 บทที่ 8 การวาดวัตถุประกอบ 
1. รู้จักเกี่ยวกับเส้นพาธ 
2. สามารถการวาดเส้นตรงได้ 
3. สามารถวาดรูปทรงแบบตายตัวได้ 
4. สามารถวาดรูปทรงอย่างอิสระได้ 

  

- ให้นักศึกษาค้นคว้าประจำหน่วย
การเรียน 

- บรรยาย 
- แสดงวิธีทำและยกตัวอย่าง 
- ให้นักศึกษาแสดงวิธีทำ 
- สรุปบทเรียน 
- แบบฝึกหัด/ทดสอบ 
- สรุปบทเรียน 
- แบบฝักหัด / ทดสอบ 

13-14 บทที่ 9 การใช้งานวัตถุ 
1. อธิบายการเลือกและเคลื่อนย้ายวัตถุได้ 
2. สามารถปรับขนาดวัตถุได้ 
3. สามรถคัดลอก และวางวัตถุโดยใช้ Paste  

- ให้นักศึกษาค้นคว้าประจำหน่วย
การเรียน 

- บรรยาย 
- แสดงวิธีทำและยกตัวอย่าง 



      in Place ได ้
4. บอกวิธีการหมุนวัตถุโดยใช้ Rotating Tool ได้ 
5. สามารถบิด และการพลิกกลับด้านวัตถุได้ 
6. อธิบายการล็อควัตถุได้ 
7. อธิบายการคร็อปรูปภาพได้ 
8. สามารถลบวัตถุได้ 
9. อธิบายการมาสก์วัตถุได้ 
10. อธิบายการรวมกลุ่ม และจัดลำดับการซ้อน

วัตถุได้ 
11.สามารถจัดเรียงวัตถุได้ 

- ให้นักศึกษาแสดงวิธีทำ 
- สรุปบทเรียน 
- แบบฝึกหัด/ทดสอบ 
- สรุปบทเรียน 
- แบบฝักหัด / ทดสอบ 

15-16 บทที่ 10 ความรู้เรื่องสีและการใช้งานสี 
1. รู้จักโมเดลการมองเห็นสีทั่วไป 
2. บอกโหมดสีที่ใช้งานโปรแกรม photoshop ได้ 
3. อธิบายการใส่สีให้วัตถุได้ 
4. อธิบายการเลือกสีจาก Color Picker, พาเนล 

Color และพาเนล Swatches ได ้
5. สามารถทำการระบายสีด้วยเครื่องมือ Eyedropper 

Tool ได้ 
6. สามารถการระบายสีแบบไล่โทนได้ 

  

- ให้นักศึกษาค้นคว้าประจำหน่วย
การเรียน 

- บรรยาย 
- แสดงวิธีทำและยกตัวอย่าง 
- ให้นักศึกษาแสดงวิธีทำ 
- สรุปบทเรียน 
- แบบฝึกหัด/ทดสอบ 
- สรุปบทเรียน 
- แบบฝักหัด / ทดสอบ 

17-18 บทที่ 11 เทคนิคการปรับแต่งภาพ 
1. รู้และเข้าใจในการตั้งค่าการแสดงผล 
2. อธิบายการปรับแต่งภาพได้ 
3. สามารถจัดวางข้อความล้อมรอบรูปภาพได้ 
4. อธิบายการใช้งานเฟรมกับภาพได้ 
5. สามารถใส่ภาพรวมกับข้อความได้ 

  

- ให้นักศึกษาค้นคว้าประจำหน่วย
การเรียน 

- บรรยาย 
- แสดงวิธีทำและยกตัวอย่าง 
- ให้นักศึกษาแสดงวิธีทำ 
- สรุปบทเรียน 
- แบบฝึกหัด/ทดสอบ 
- สรุปบทเรียน 
- แบบฝักหัด / ทดสอบ 

    ประเมินผลผู้เรียน  



 
7. กิจกรรมการเรียนรู้ 
    7.1  กิจกรรมครู 

7.1.1 จัดเตรียมเอกสาร หนังสืออ้างอิง  สื่อการเรียนทั้งสื่อโสตทัศน์ สื่อสิ่งพิมพ์ ตัวอย่างแฟ้มสะสม
ผลงานของผู้เรียน 

7.1.2 นำเข้าสู่บทเรียนโดยการประเมินผู้เรียนที่หลากหลาย เช่น ถามความรู้พ้ืนฐานทั้งห้อง หรือ ทำ
แบบฝึกหัดเรียน   

7.1.3 การให้ข้อมูลหรือการสอน โดยผู้สอนให้ผู้เรียนศึกษาจากใบความรู้ แบบฝึกหัด สรุปสาระการเรียนรู้
ประจำหน่วยการเรียน ตัวอย่างแฟ้มสะสมผลงานรุ่นพ่ี หรือชุดการเรียน สื่อโสตทัศน์แล้วทำแบบฝึกหัดหากยังทำ
ได้ไม่ครบให้ทบทวนบทเรียนให้ผู้เรียนใหม่ 
 
 

7.1.4 สังเกต บันทึกพฤติกรรมผู้เรียนขณะศึกษาบทเรียน คอยช่วยเหลือให้คำแนะนำเม่ือผู้เรียนต้องการ 
7.1.5 การประยุกต์ใช้ โดยให้ใบมอบหมายงานแก่ผู้เรียน ดำเนินงานตามจุดประสงค์ที่กำหนดไว้ในใบงาน 

โดยดำเนินงานในลักษณะของขั้นตอนทางวิทยาศาสตร์ เริ่มตั้งแต่ ระบุความต้องการของปัญหา  ขั้นศึกษาเพ่ือหา
สมมติฐาน  ขั้นปฏิบัติเพื่อหาคำตอบ  และสรุปผลของคำตอบที่ได้จากข้ันปฏิบัติ 

7.1.6 สังเกต  บันทึกพฤติกรรมผู้เรียนขณะดำเนินงานตามใบงาน  คอยช่วยเหลือให้คำแนะนำเมื่อผู้เรียน
ต้อง 

7.1.7 แบ่งกลุ่มผู้เรียนเพ่ือดำเนินการตามใบงาน แล้วผู้สอนเดินสำรวจการดำเนินงานตามใบงานของ
ผู้เรียนหากพบว่าผู้เรียนดำเนินการยังไม่ถูกต้องให้คอยชี้แนะวิธีที่ถูกต้องทันที 

7.1.8 การตรวจสอบผลการเรียนรู้ ให้ผู้เรียนร่วมกันกำหนดหัวข้อที่จะประเมินงานร่วมกับผู้เรียน
ตรวจสอบชิ้นงานเพื่อประเมินและแก้ไขข้อบกพร่อง 

7.1.9 สังเกต บันทึกพฤติกรรมผู้เรียนขณะผู้เรียนทำงาน คอยช่วยเหลือให้คำแนะนำเม่ือผู้เรียนต้องการ 
7.1.10  หากผู้เรียนได้แบ่งกลุ่มรับผิดชอบการดำเนินการตามใบงานให้ตัวแทนกลุ่มหรือสมาชิกท้ังกลุ่มลุก

ขึ้นบอกคำตามพร้อมทั้งวิธีการได้มาซึ่งคำตอบ 
7.1.11   ครูอธิบายเนื้อหา พร้อมแสดงวิธีทำครูให้นักศึกษามีส่วนร่วมในการเรียนการสอน เช่น 

- ถามตอบ 
- ร่วมกันสรุป 
- ร่วมกันวิเคราะห์หาเทคนิคและแนวทางท่ีดีและง่าย 



7.1.12 ครูให้นักศึกษาทำแบบฝึกหัดทบทวนบทเรียนเป็นรายบุคคลพร้อมให้อธิบายและสรุปหลักการ
ออกมาเป็นแนวคิดตามความเข้าใจของแต่ละบุคคล 

7.1.13 ครูให้นักศึกษาตอบคำถามพร้อมออกมาสาธิตวิธีการทำโดยวิธีการสุ่มนักศึกษาในห้อง 
7.1.14 ครูจัดให้นักศึกษาทำกิจกรรมกลุ่ม เพ่ือให้เกิดความคิดที่หลากหลายในกระบวนการวิเคราะห์หา

เหตุและผล แล้วส่งตัวแทนออกไปแสดงวิธีการในชั่วโมงเรียนในแต่ละภาระงาน 
7.1.15 ครูสรุปพร้อมแนะนำเทคนิคและกระบวนการที่ถูกต้อง 
7.1.16 ผู้เรียนทำภาระงานทุกหน่วยการเรียนตามใบงานประจำหน่วยส่งในเวลาที่กำหนด แล้วหลังจาก

ครูได้ตรวจชิ้นงานให้ผู้เรียนทำการแก้ไขให้ถูกต้องและเก็บสะสมชิ้นงานเพ่ือจัดทำแฟ้มสะสมชิ้นงานในทุกหน่วย
การเรียนรู้หลังเสร็จสิ้นกระบวนการเรียนการสอน 
 
 
 

7.2  กิจกรรมผู้เรียน 
7.2.1 จัดเตรียมเอกสาร หนังสือแบบเรียน หนังสืออ้างอิง ตามท่ีผู้สอนและบทเรียนกำหนด 
7.2.2 นำเข้าสู่บทเรียนโดยรับการชี้แจงวิธีการเรียนรู้ ระยะเวลาที่ทำการเรียนการสอน หลักการแนวทาง

การเรียน การประเมินผลการเรียน  
7.2.3 จัดกลุ่มกันศึกษา ค้นคว้า หาข้อมูลจากเอกสารตำรา หนังสือเรียน หนังสืออ้างอิง และเรียนจากชุด

การเรียนและสื่อการเรียนต่าง ๆ และผู้เรียนร่วมกันแลกเปลี่ยนความรู้ความคิดเห็นซึ่งกันและกันเพ่ือหาความคิด
รวบยอดให้เกิดในแต่ละสาระการเรียนรู้ 

7.2.4 การให้ข้อมูล โดยศึกษาเนื้อหาจากใบความรู้ ใบงาน หรือสื่อการเรียนต่าง ๆ แล้วทำแบบฝึกหัด 
หากยังทำได้ไม่ครบทำการทบทวนบทเรียนใหม่ หากมีปัญหาข้อขัดข้องให้ขอคำแนะนำจากผู้สอนและเพ่ือนในกลุ่ม 

7.2.5 การประยุกต์ใช้  โดยศึกษาใบมอบหมายงาน ดำเนินงานตามจุดประสงค์ในแต่ละสาระการเรียนรู้
ตามใบงานที่กำหนดไว้โดยดำเนินงานในลักษณะของขั้นตอนทางวิทยาศาสตร์ เริ่มตั้งแต่ ระบุความต้องการของ
ปัญหา  ขั้นศึกษาเพ่ือหาสมมติฐาน  ขั้นดำเนินการปฏิบัติเพ่ือให้ได้มาซึ่งคำตอบ  สรุปผลของคำตอบที่ได้มาจากข้ัน
ปฏิบัติ หน้าห้องเรียน หรือส่งครู ตามที่ได้กำหนดไว้ในใบมอบหมายงาน  หากมีปัญหาให้ขอคำแนะนำจากผู้สอน
และเพ่ือในกลุ่มหรือเพ่ือในห้องเรียน 

7.2.6 การตรวจสอบผลการเรียนรู้  โดยทำรายงานผลการดำเนินงาน ร่วมกับผู้สอนกำหนดหัวข้อที่จะ
ประเมินงานในแต่ละสาระการเรียนรู้ และผู้เรียนมีส่วนร่วมในการตรวจสอบชิ้นงานเพ่ือประเมินและแก้ไข
ข้อบกพร่อง หากมีปัญหาขัดข้องให้ขอคำแนะนำจากผู้สอนและเพ่ือนในกลุ่ม 
 



8. สื่อการเรียนการสอน 
1.  หนังสือประกอบการเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก     
2 .ใบงานประจำหน่วยการเรียนรู้แต่ละหน่วย 
3 . แบบฝึกหัดประจำหน่วยการเรียนรู้ 
4 . ตัวอย่างแฟ้มสะสมชิ้นงาน 
5 . ชุดการสอน PowerPoint  แต่ละหน่วยการเรียน 
6.  VCD  CAI      
7. บทเรียนออนไลน์ 
8 .คอมพิวเตอร์ 
  

9. การวัดผลประเมินผล   เก็บคะแนนระหว่างการดำเนินกิจกรรมการเรียนรู้   100  คะแนน   
1. คุณธรรมและจริยธรรม     20   คะแนน 
2. ใบงาน/แบบฝึกหัด(ชิ้นงาน/แฟ้มสะสมผลงาน)   30  คะแนน 
3. ทดสอบระหว่างเรียน       20  คะแนน 
4. ประเมินผลผู้เรียนหลังเรียน     30  คะแนน    

 

10.  การวัดและประเมินผล 

10.1  ผู้เรียนปฏิบัติภาระงานที่มอบหมายเสร็จทันเวลาที่กำหนดและถูกต้อง 
10.2  ผู้เรียนมีความสนใจในการตอบคำถามและการสรุปผลการเรียนรู้แต่ละหน่วยการเรียนได้อย่าง

ถูกต้อง 
10.3 เกิดความคิดรวบยอดในแต่ละหน่วยการเรียนรู้ และรู้หลัก เทคนิค และวิธีการหาคำตอบได้อย่าง

รวดเร็วและถูกต้อง 
10.4  ผ่านการทดสอบประจำหน่วยและประมวลผลสาระการเรียนรู้ตลอดภาคเรียน 
10.5  ผู้เรียนเกิดทักษะ 
10.6  สังเกตพฤติกรรมและการแสดงออกถึงการเล็งเห็นคุณค่าของการนำมาใช้ในระบบคอมพิวเตอร์ของ

ผู้เรียน 
10.7 ความสนใจในการเรียนรู้  การค้นคว้าเพื่อแสดงความรู้และคำตอบ  การมีส่วนร่วมในกิจกรรม 
10.8 การซักถามและการตอบคำถาม 
10.9 แบบฝึกหัดและกิจกรรมการฝึกทักษะ 



10.10 การทำงานเป็นทีม (ให้ความสำคัญในการทำงานเป็นทีม) 
10.11 การประเมินโดยกลุ่มเพ่ือน การประเมินตนเอง 
10.12 การเขียนรายงานผลงาน และการแก้ไขส่วนที่บกพร่องในชิ้นงานที่มอบหมาย 
10.13 แฟ้มสะสมผลงานที่มอบหมายในแต่ละหน่วยการเรียน 

 
 เครื่องมือวัดผล 

1. ด้านคุณธรรมจริยธรรม (จิตพิสัย) 
1.1  การปฏิบัติตามกฎระเบียบของสถานศึกษา          

1.2  ตรงต่อเวลา         

1.3 สนใจปฏิบัติงานที่มอบหมายและความกระตือรือร้นในการเรียน  
1.4 ความรับผิดชอบ        
1.5 ความสะอาดและความเป็นระเบียบ      
1.6 ความซื่อสัตย์        

   1.7 การเห็นคุณค่าและมีเจตที่ดี       

2.  ด้านวิชาการ (ด้านทักษะ) 

2.1   ตอบคำถาม      
2.2 หลักการและเทคนิคในกระบวนการคิด                                                        
2.3 มีความรู้ความเข้าใจ                           
2.4 ผลงานการปฏิบัติตามใบงานมีความถูกต้อง                                          
2.5 มีทักษะและวิเคราะห์การใช้งานได้                                                      
2.6 ความสามารถในการนำความรู้ไปประยุกต์ใช้ในการทำงานกับคอมพิวเตอร์                    
2.7  ทำแบบฝึกหัดหลังเรียนมีความเข้าใจ                                                        
2.8  กระบวนการแก้ปัญหาและกระบวนการสืบค้นเพื่อหาคำตอบ 
2.9 มีโนภาพและความคิดรวบยอดในการในกระบวนการเรียนรู้ประจำหน่วย            
 

11.  แหล่งการเรียนรู้ 
11.1  ห้องสมุดสถานศึกษา 



11.2  ห้องปฏิบัติการคอมพิวเตอร์และสารสนเทศ 
11.3  ผู้ปกครอง  เพื่อน ๆ   รุ่นพี่    และบุคลากรในสถานศึกษา 
11.4  หนังสือ   E-book   , Elearning   ,  Website  ที่เก่ียวข้อง 
11.5 ครูผู้สอน 

 
12.  ผลงานผู้เรียน 

12.1  รวบรวมผลงานที่เป็นผลงานที่ถูกต้องในภาระงานที่มอบหมาย  และผู้เรียนทำการปรับปรุงแก้ไข
ชิ้นงานที่ยังไม่ถูกต้องให้ถูกต้อง แล้วจัดทำเป็นแฟ้มสะสมผลงาน 

12.2  แฟ้มสะสมผลงานการทดสอบของผู้เรียน 
 
13. เอกสารอ้างอิ ง  
อ. ชิษณุพงศ์ ธัญญลักษณ์. การผลิตสื่อสิ่งพิพม ์ ระดับชั้น ปวช. กรุงเทพมหานคร: 

               บริษัท ซัคเซสมีเดียจำกัด, 2556. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



แผนจัดการเรียนรู้  วิชา  การใช้โปรแกรมคอมพิวเตอร์กราฟิก                รหัสวิชา 21909-2019 ชั้น ปวช.     
หน่วยที่ 1    เรื่อง   ความรู้พ้ืนฐานเกี่ยวกับสื่อสิ่งพิมพ์               สัปดาห์ที่  1  เวลา 4   ชั่วโมง 

1. สาระสำคัญ 
สื่อสิ่งพิมพ์ เป็นส่วนหนึ่งของสื่อสารมวลชน จำแนกได้ 2 ประเภทได้แก่ สื่อสิ่งพิมพ์ที่กำหนดระยะ เวลา

การเผยแพร ่และไม่กำหนดระยะเวลาการเผยแพร่ สื่อสิ่งพิมพ์มีองค์ประกอบสำคัญ ได้แก่ เนื้อหา  ภาพ และการ

ออกแบบหน้าที่สื่อสิ่งพิมพ์ ได้แก่ ให้ข้อมูลข่าวสาร (to inform) ให้ความรู้ความเข้าใจ (to educate) ให้ความ

คิดเห็น (to give an opinion) ให้ความบันเทิง (to entertain) และให้การโฆษณา (to advertise) ในประเด็น

บทบาทของสื่อสิ่งพิมพ์ ได้แก่ สถาบันการศึกษา (Educational institute) ตลาดเสรีแห่งความคิด (Freedom of 

Opinion market place) ผู้เฝ้ายามข่าวสาร (Gatekeeper) และองค์กรควบคุมบรรทัดฐานสังคม (Society 

Norm Inspector) 

2 . จุดประสงค์การเรียนรู้ 

1. มีความรู้ความเข้าใจและบอกลำดับประวัติการพิมพ์ทั้งในและต่างประเทศได้ 
2 . มีความรู้ความเข้าใจและบอกความแตกต่างระหว่างกระบวนการพิมพ์แบบดั้งเดิม  และการพิมพ์ร่วม
สมัยได ้
3. มีความรู้ความเข้าใจและจำแนกประเภทสื่อสิ่งพิมพ์ได้ 
4. มีความรู้ความเข้าใจและบอกองค์ประกอบของสื่อสิ่งพิมพ์ได้    
5. มีความรู้ความเข้าใจและบอกหน้าที่ของสื่อสิ่งพิมพ์ได้  
6.   มีความรู้ความเข้าใจและอธิบายบทบาทของสื่อสิ่งพิมพ์ได้ 

3. สาระการเรียนรู้ 

1. ประวัติการพิมพ์ทั้งในและต่างประเทศ 
2. กระบวนการพิมพ์แบบดั้งเดิมและการพิมพ์ร่วมสมัย 
3. ประเภทของสื่อสิ่งพิมพ์  
4. องค์ประกอบของสื่อสิ่งพิมพ์ 
5. หน้าที่ของสื่อสิ่งพิมพ์  
6. บทบาทของสื่อสิ่งพิมพ์ 

4. การวัดประเมินผล 



ทักษะพิสัย  มีกระบวนการวางแผน และปฏิบัติได้ตรงตามเป้าหมายที่กำหนด 
พุทธิพิสัย มีความจำ ความเข้าใจ และการนำไปประยุกต์ให้เกิดประโยชน์ต่อการเรียน หรือการใช้

ชีวิตประจำวัน 
จิตพิสัย ปฏิบัติได้ตามศักยภาพที่มีอยู่ ตรงต่อเวลา และสนใจในการสืบค้นหาความรู้ ทุกช่วง

โอกาสเพ่ือพัฒนาตนเอง 
5.  กิจกรรมการเรียนการสอน 

กิจกรรมครู กิจกรรมนักเรียน 
ขั้นนำเข้าสู่บทเรียน (สัปดาห์ละ 30 นาที) 
1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 
2. ให้นักศึกษาค้นคว้าสื่อสิ่งพิมพ์ 
3. ร่วมสนทนาเกี่ยวกับสื่อสิ่งพิมพ์ 

 
1.  ให้ความร่วมมือกับครูในการตรวจสอบ 
2. ค้นคว้าเรื่อง สื่อสิ่งพิมพ์ 
3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน (สัปดาห์ละ 180 นาที) 
1. บอกจุดประสงค์การเรียน 
2. บรรยาย อธิบาย ยกตัวอย่าง ในแต่ ละหัวข้อ

การเรียนให้นักศึกษา  
3. ครูบอกวิธีการ และแนวคิดในการปฏิบัติที่

ถูกต้องให้แก่ผู้เรียน 
4. ประเมินพฤติกรรมรายบุคคลโดยครูจะ

ซักถามในแต่ละคน 

 

1. ฟัง ทำความเข้าใจและซักถาม 
2. แบ่งกลุ่ม 
3. ฟัง ทำความเข้าใจและปฎิบัติตาม 
4. ผู้เรียนซักถามข้อสงสัยและจดบันทึก 
5.  รับการประเมิน 
 

ขั้นสรุป(สัปดาห์ละ 30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. นักเรียนสอบถามข้อสงสัย 
3. ฟังและจดบันทึก 
4. ทำแบบทดสอบท้ายบท 
 

 



6.  กิจกรรมการเรียนรู้ 

 ก่อนเรียน 
 ค้นคว้าเกี่ยวกับ สื่อสิ่งพิมพ์ 

ขณะเรียน 
1. แบ่งกลุ่มเพื่อศึกษา 
2. จดบันทึก สาระการเรียนรู้  
3. ทำใบงาน  ตรวจสอบใบงาน แก้ไขใบงาน 
4. ทบทวนเนื้อหา 
หลังเรียน 

1. ร่วมกันสรุปบทเรียน พร้อมบันทึกผลการสรุป แล้วลุกขึ้นนำเสนอกับครูผู้สอน 
2. ผู้เรียนและครูผู้สอนร่วมกันประเมินข้อสรุปของผู้เรียนที่ออกแสดงความคิดเห็นเพ่ือให้ได้ข้อสรุปที่

ถูกต้อง  และครูผู้สอนแสดงความชื่นชมกับผู้เรียนทุกคนที่ออกแสดงความคิดเห็นและมีส่วนร่วมใน
กิจกรรมที่มอบหมาย 

3. ทำแบบฝึกหัดหลังเรียน 
4. ร่วมกันเฉลยแบบฝึกหัด 

 

7. สื่อการเรียนการสอนประจำหน่วย 

1. หนังสือเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก 
2. ใบความรู้ประจำหน่วย 
3. ใบงานและแบบฝึกหัด 
4. เครื่องไมโครคอมพิวเตอร์ 
5.  แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 
6. ซีดีสื่อการสอน 

 

8. วัดผลประเมินผลประจำหน่วย 



1. สังเกตผู้เรียนมีความสนใจ เกิดความเข้าใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน
การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจำหน่วย  

2. ทำใบงานได้อย่างถูกต้อง  ทันเวลาที่กำหนด  ใบงานสะอาดและเป็นระเบียบ 
3. ผู้เรียนทำแบบฝึกหัดหลังเรียนได้ถูกต้อง  โดยได้คะแนน   50%  เป็นอย่างต่ำ 

 

9. กิจกรรมเสนอแนะประจำหน่วย 

1. ผู้เรียนต้องให้ความสนใจในการศึกษา  เพ่ือหาเทคนิค วิธีการ หรือหลักการง่ายเพ่ือให้หาคำตอบได้
อย่างถูกต้อง และรวดเร็ว โดยการ ตั้งใจฟังหลักการ เทคนิควิธีการที่ครูผู้สอนสรุปในขณะที่ทำการสอน และนำข้อ
สงสัยซักถามครูในการเรียนทุกครั้งที่เกิดความสับสน และไม่เข้าใจ 

2. ผู้มีการทบทวนบทเรียน ตลอดเพ่ือเสริมสร้างความเข้าใจอย่างแท้จริง 
3. ผู้เรียนหมั่นทำใบงาน แบบฝึกหัด และแก้ไขข้อที่ผิดให้ถูกต้องเสมอ 
4. ผู้เรียนต้องสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกับความ

จำเป็นในการนำไปประยุกต์ใช้ให้เกิดขึ้นโดยตนเองให้ได้เพ่ือเกิดความรู้ความเข้าใจอย่างแท้จริงไม่ใช่เกิดจากการ
ท่องจำ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

เฉลยแบบฝึกหัดท้ายบทที่ 1 

1. จงสรุปประวัติการพิมพ์ทั้งในและต่างประเทศ พอเข้าใจ 

 ในต่างประเทศการพิมพ์ระยะแรก ชาวจีนได้สลักตราประจำตระกูล หรือสลักชื่อบนงาช้าง หรือกระดูกสัตว์
เพ่ือทำแหวนและตราประทับ ต่อมาใช้กระดาษทำจากเยื่อไม้ และใช้เขม่าไฟเป็นหมึก ขณะที่ชาวอียิปต์ใช้ถ่าน 
ชาวญี่ปุ่นใช้แกะตัวพิมพ์ด้วยไม้แล้วทาหมึกพิมพ์บนกระดาษ จนกระทั่งชาวจีนได้ใช้ดินเหนียวปั้นเป็นตัวพิมพ์
แล้วเผาไฟ ชาวเกาหลีใช้วิธีการหล่อตัวพิมพ์ ส่วนชาวยุโรปเริ่มเลียนแบบไปพิมพ์เป็นบล็อกไม้แล้วระบายสี 
และเริ่มมีการกัดแม่พิมพ์เป็นร่องลึกโดยใช้ทองแดง จนกระทั่งชาวเยอรมันชื่อ “กูเตนเบริก” ได้หล่อตัวพิมพ์
โลหะ ซึ่งเป็นต้นแบบระบบพื้นนูน หรือเลตเตอร์เพรส จากนั้นได้มีการพัฒนาการพิมพ์พ้ืนราบ หรือการพิมพ์
หิน  

ในประเทศไทยเกิดการพิมพ์จากคณะสอนศาสนานำเข้ามาเพ่ือการพิมพ์คำสอนทางศาสนา แล้วพัฒนาการ
หล่อตัวพิมพ์ภาษาไทยขึ้นใช้ในการพิมพ์ 

 

2. กระบวนการใช้โปรแกรมคอมพิวเตอร์กราฟิกแบบดั้งเดิมและร่วมสมัย มีอะไรบ้าง 

 กระบวนการพิมพ์ดั้งเดิม  พิจารณาจากกระบวนการพิมพ์ได้ ได้แก่   

 1. กระบวนการวางแผนและการ  2. การเรียงพิมพ์และภาพ  3. การจัดแบบตัวพิมพ์  4. การเตรียม
อาร์ตเวิร์ค  และ 5.  การเตรียมต้นฉบับภาพ  

 กระบวนการพิมพ์ร่วมสมัย เป็นการประยุกต์ซอฟท์แวร์คอมพิวเตอร์มาใช้ในงานกระบวนการพิมพ์ ได้แก่  

 1. การเตรียมภาพ  2. ซอฟท์แวร์การเตรียมตัวหนังสือ  3. ซอฟท์แวร์การตรวจคำถูกผิด  และ 4. การ
ออกแบบจัดหน้าและประกอบหน้าต้นฉบับ  

 

3. สื่อสิ่งพิมพ์มีกี่ประเภท โดยใช้เกณฑ์การแผยแพร่เป็นตัวบ่งชี้ 

 2 ประเภทได้แก่ สื่อสิ่งพิมพ์ ที่กำหนดระยะเวลาเผยแพร่ (Period) และ สื่อสิ่งพิมพ์ ที่ไม่กำหนดระยะเวลา
เผยแพร่ (Non-period) 

 

 



4. จงสรุปแนวคิดและสาระสำคัญเกี่ยวสื่อสิ่งพิมพ์ ที่กำหนดระยะเวลาเผยแพร่ ได้แก่ 

• จดหมายข่าว เป็นหนึ่งในองค์ประกอบแบบจำลองการสื่อสารมวลชน ประเภทสิ่งพิมพ์รายคาบ เป็น
ตัวกลางเพ่ือส่งผ่านเนื้อหาไปสู่เป้าหมาย และยังเป็นเครื่องมือในการบริหารงาน ในองค์กรทั้งภาครัฐ 
และเอกชน รวมทั้งเป็นเครื่องในการประสานสัมพันธ์ในองค์กรและนอกองค์กร   

• หนังสือพิมพ์ เป็นสิ่งพิมพ์ที่นำเสนอช้อมูลข่าวสาร ซึ่งมีท้ังการเน้นเชิงคุณภาพ นำเสนอเนื้อหาและไป
ทางเรื่องหนักสมอง นอกจากนี้ยังมีการเน้นปริมาณยอดผู้อ่าน โดยนำเสนอเนื้อหาเบาสมอง 

• นิตยสาร เป็นสิ่งพิมพ์ที่นำเสนอข้อมูล และข่าวสารที่เน้นเรื่องใดเรื่องหนึ่ง อาชีพใดอาชีพหนึ่ง  หรือ
คนกลุ่มใดกลุ่มหนึ่ง 

 

5. จงสรุปแนวคิดและสาระสำคัญเก่ียวสื่อสิ่งพิมพ์ ที่ไม่กำหนดระยะเวลาเผยแพร่ ได้แก่ 

• ใบปลิว  เป็นเอกสารที่นำเสนอข้อมูลข่าวสารบนกระดาษใบเดียว 

• แผ่นพับ เป็นเอกสารที่นำเสนอข้อมูลข่าวสารบนกระดาษท่ีมีการพับหรือเย็บเป็นเล่ม 

• โปสเตอร์ เป็นแผ่นกระดาษใบเดียว ขนาดใหญ่มีเนื้อความน้อย ผู้อ่านที่เดินทางไปมาสามารถอ่านได้
สะดวก 

 

6. จงสรุปองค์ประกอบสำคัญของสื่อสิ่งพิมพ์โดยสังเขป 

 องค์ประกอบของสื่อสิ่งพิมพ์ มีส่วนสำคัญ 2 ประการได้แก่ เนื้อหาและการออกแบบ 

 

7. จงอธิบายหน้าที่สื่อสิ่งพิมพ์ต่อไปนี้ พอเข้าใจ 

• ให้ข้อมูลข่าวสาร (to inform) บอกข่าวสาร เหตุการณ์ที่เกิดขึ้น 

• ให้ความคิดความเห็น (to give an opinion) สะท้อนความคิดเห็นของคนในสังคม 

• ให้ความรู้ความเข้าใจ (to educate ให้ความรู้ความเข้าใจกับวัฒนธรรม ประเพณี และสิ่งดีงามในสังคม 

• ให้การบันเทิง (to entertain) ให้สิ่งที่เข้ามาผ่อนคลาย เป็นเรื่องเบาสมอง 

• ให้การโฆษณา (to advertise) เป็นข้อมูลในทางโน้มน้าว ชักชวน จูงใจให้มีผลทางธุรกิจและอุตสาหกรรม 

8. จงอธิบายบทบาทสื่อสิ่งพิมพ์ต่อไปนี้ พอเข้าใจ 



• สถาบันการศึกษา (Educational institute) เป็นหนังสือ ตำราและเอกสารที่ให้ข้อมูล และความรู้ 

• ตลาดเสรีแห่งความคิด (Freedom of Opinion market place) เป็นแหล่งฐานการคิด การทำ และ
การแก้ไขปัญหาได้ 

•  ผู้เฝ้ายามข่าวสาร (Gatekeeper) เป็นประตูข่าวสาร นำเสนอข่าว และข้อเท็จจริง 

•  องค์กรควบคุมบรรทัดฐานสังคม (Society Norm Inspector) เป็นมาตรฐานที่สื่อให้คนในสังคมยึด
ปฏิบัติและควบคุมให้สมาชิกได้ประพฤติปฏิบัติ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



แผนจัดการเรียนรู้  วิชา  การใช้โปรแกรมคอมพิวเตอร์กราฟิก                 รหัสวิชา 21909-2019 ชั้น ปวช.     
หน่วยที่ 2    เรื่อง   หลักการออกแบบสื่อสิ่งพิมพ์                         สัปดาห์ที่  2-3 เวลา 8   ชัว่โมง 

1. สาระสำคัญ 
บทที่ผ่านมาเราได้เรียนรู้ถึงประเภท และองค์ประกอบของงานสื่อสิ่งพิมพ์กันไปแล้ว สำหรับเนื้อในบทนี้เราจะมา

เรียนรู้ถึงหลักการออกแบบสื่อสิ่งพิมพ์ เพ่ือให้งานสิ่งพิมพ์ของเราดูน่าสนใจ 

2 . จุดประสงค์การเรียนรู้ 

1. เพ่ือให้ผู้เรียนสามารถอธิบายองค์ประกอบการออกแบบได้ 

2. เพ่ือให้ผู้เรียนสามารถบอกหลักการออกแบบได้    

3. เพ่ือให้ผู้เรียนสามารถบอกองค์ประกอบต้นฉบับงานพิมพ์ได้ 

4. เพ่ือให้ผู้เรียนสามารถระบุเทคโนโลยีเตรียมต้นฉบับงานพิมพ์ได้ 

5. เพ่ือให้ผู้เรียนสามารถอธิบายการออกแบบหนังสือพิมพ์ได้ 

3. สาระการเรียนรู้ 

1. องค์ประกอบการออกแบบ 

2. หลักการออกแบบ 

3. การออกแบบหนังสือพิมพ์ 

4. ต้นฉบับงานพิมพ์ 

5. เทคโนโลยีเตรียมต้นฉบับงานพิมพ์ 

4. การวัดประเมินผล 

ทักษะพิสัย  มีกระบวนการวางแผน และปฏิบัติได้ตรงตามเป้าหมายที่กำหนด 

พุทธิพิสัย มีความจำ ความเข้าใจ และการนำไปประยุกต์ให้เกิดประโยชน์ต่อการเรียน 

หรือการใช้ชีวิตประจำวัน 

จิตพิสัย ปฏิบัติได้ตามศักยภาพที่มีอยู่ ตรงต่อเวลา และสนใจในการสืบค้นหาความรู้ ทุก

ช่วงโอกาสเพื่อพัฒนาตนเอง 

 



5.  กิจกรรมการเรียนการสอน 

กิจกรรมครู กิจกรรมนักเรียน 
ขั้นนำเข้าสู่บทเรียน (สัปดาห์ละ 30 นาที) 
1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 

2. ให้นักศึกษาค้นคว้าการออกแบบสื่อสิ่งพิมพ์ 

3. ร่วมสนทนาเกี่ยวกับการออกแบบสื่อสิ่งพิมพ์ 

 

1.  ให้ความร่วมมือกับครูในการตรวจสอบ 

2. ค้นคว้าเรื่อง การออกแบบสื่อสิ่งพิมพ์ 

3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน (สัปดาห์ละ 180 นาที) 
1. บอกจุดประสงค์การเรียน 

2. บรรยาย อธิบาย ยกตัวอย่าง ในแต่ ละหัวข้อ

การเรียนให้นักศึกษา  

3. ครูบอกวิธีการ และแนวคิดในการปฏิบัติที่

ถูกต้องให้แก่ผู้เรียน 

4. ประเมินพฤติกรรมรายบุคคลโดยครูจะซักถาม

ในแต่ละคน 

 

1. ฟัง ทำความเข้าใจและซักถาม 
2. แบ่งกลุ่ม 
3. ฟัง ทำความเข้าใจและปฎิบัติตาม 
4. ผู้เรียนซักถามข้อสงสัยและจดบันทึก 
5.  รับการประเมิน 
 

ขั้นสรุป (สัปดาห์ละ 30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 

2. นักเรียนสอบถามข้อสงสัย 

3. ฟังและจดบันทึก 

4. ทำแบบทดสอบท้ายบท 

 

6.  กิจกรรมการเรียนรู้ 

 ก่อนเรียน 
 ค้นคว้าการออกแบบสื่อสิ่งพิมพ์ 



ขณะเรียน 
1. แบ่งกลุ่มเพื่อศึกษา 
2. จดบันทึก สาระการเรียนรู้  
3. ทำใบงาน  ตรวจสอบใบงาน แก้ไขใบงาน 
4. ทบทวนเนื้อหา 
หลังเรียน 

1. ร่วมกันสรุปบทเรียน พร้อมบันทึกผลการสรุป แล้วลุกขึ้นนำเสนอกับครูผู้สอน 
2. ผู้เรียนและครูผู้สอนร่วมกันประเมินข้อสรุปของผู้เรียนที่ออกแสดงความคิดเห็นเพ่ือให้ได้ข้อสรุปที่

ถูกต้อง  และครูผู้สอนแสดงความชื่นชมกับผู้เรียนทุกคนที่ออกแสดงความคิดเห็นและมีส่วนร่วมใน
กิจกรรมที่มอบหมาย 

3. ทำแบบฝึกหัดหลังเรียน 
4. ร่วมกันเฉลยแบบฝึกหัด 

 

7. สื่อการเรียนการสอนประจำหน่วย 

1. หนังสือเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก 
2. ใบความรู้ประจำหน่วย 
3. ใบงานและแบบฝึกหัด 
4. เครื่องไมโครคอมพิวเตอร์ 
5. แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 
6. ซีดีสื่อการสอน 

 

8. วัดผลประเมินผลประจำหน่วย 

1. สังเกตผู้เรียนมีความสนใจ เกิดความเข้าใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน
การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจำหน่วย  

2. ทำใบงานได้อย่างถูกต้อง  ทันเวลาที่กำหนด  ใบงานสะอาดและเป็นระเบียบ 
3. ผู้เรียนทำแบบฝึกหัดหลังเรียนได้ถูกต้อง  โดยได้คะแนน   50%  เป็นอย่างต่ำ 

 



 

9. กิจกรรมเสนอแนะประจำหน่วย 

1. ผู้เรียนต้องให้ความสนใจในการศึกษา  เพ่ือหาเทคนิค วิธีการ หรือหลักการง่ายเพ่ือให้หาคำตอบได้
อย่างถูกต้อง และรวดเร็ว โดยการ ตั้งใจฟังหลักการ เทคนิควิธีการที่ครูผู้สอนสรุปในขณะที่ทำการ
สอน และนำข้อสงสัยซักถามครูในการเรียนทุกครั้งที่เกิดความสับสน และไม่เข้าใจ 

2. ผู้มีการทบทวนบทเรียน ตลอดเพ่ือเสริมสร้างความเข้าใจอย่างแท้จริง 
3. ผู้เรียนหมั่นทำใบงาน แบบฝึกหัด และแก้ไขข้อที่ผิดให้ถูกต้องเสมอ 
4. ผู้เรียนต้องสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกับความ

จำเป็นในการนำไปประยุกต์ใช้ให้เกิดขึ้นโดยตนเองให้ได้เพ่ือเกิดความรู้ความเข้าใจอย่างแท้จริงไม่ใช่
เกิดจากการท่องจำ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

เฉลยแบบฝึกหัดท้ายบทที่ 2 

1. จงบอกองค์ประกอบการออกแบบโดยสังเขป 

 การออกแบบ มีองค์ประกอบต่างๆ ได้แก ่เส้น รูปทรง พ้ืนผิว พ้ืนที ่ขนาด ความเข้มข้นและสี 

 

2. หลักการออกแบบ มีอะไรบ้าง อธิบายพอเข้าใจ 

  หลักการออกแบบ ได้แก ่ความสมดุล จังหวะหรือลีลา การเน้นและเอกภาพ 

การใช้เรื่องความสมดุล (Balance) ที่การกระจายน้ำหนักในการจัดวางองค์ประกอบในหน้างานออกแบบ  

  การใช้เรื่องจังหวะหรือลีลา (Rythm) ที่สร้างสรรค์องค์ประกอบที่ซ้ำๆ กันอาศัยความหลากหลาย 

เรื่องใช้การเน้น (Emphasis) ที่เก่ียวข้องกับสิ่งที่ต้องการให้ออกมาโดดเด่นเพ่ือการที่จะเห็นได้เด่นชัดก
ว่องค์ประกอบอื่น  

 เรื่องความเป็นเอกภาพ (Unity) ที่เก่ียวข้องกับการจัดองค์ประกอบทั้งหลาย ให้ดูเสมือนเป็นอันหนึ่งอัน
เดียวกัน หรือจัดให้เข้าด้วยกัน ประหนึ่งเป็นพวกเดียวกัน 

 

3. จงบอกเทคโนโลยีเตรียมต้นฉบับงานพิมพ์ โดยสังเขป 

1. เครื่องคอมพิวเตอร์ (Computer Hardware) และชุดคำสั่ง (Computer Software) ประกอบด้วย 
คำสั่งระบบปฏิบัติการ (Operating System Software) คำสั่งพ้ืนฐานของระบบรับ-ส่ง (BIOS: Basic 
Input Output System)   

2. ชุดคำสั่งในการสื่อสารคนกับเครื่อง เช่น ดอส (DOS) ใช้ คำ พยางค ์ฯลฯ เพ่ือใช้เขียนเป็นคำสั่ง (CUI 
: Command Line User Interface) หรือวินโดวส์  (Windows) หรือแมคอินทอช (MacIntosh) ใช้รปู  
ภาพกราฟิกแทนคำสั่ง (GUI : Graphic User Interface)   

 3. ชุดคำสั่งใช้งาน (Application Software) เช่น โปรแกรมเพ่ือใช้ออกแบบหรือจัดหน้า (Page Layout) 
ใช้เพื่อปรับปรุงตกแต่งภาพ (Photo Retouch) ใช้เพ่ือสร้างสรรค์ภาพ อาจเป็นการวาดหรือเขียนภาพ 
(Draw and Paint) เป็นต้น 

4. ชุดคำสั่งสำเร็จรูปตรวจทานทางภาษา การใช้โปรแกรมช่วยในการค้นหาคำและแทนที่คำ การ
ตรวจสอบไวยากรณ์ 



 

4. การเตรียมต้นฉบับทางการพิมพ์คืออะไร  

เป็นการจัดหน้างานพิมพ์  จัดเตรียมภาพและตรวจความถูกต้องของงานพิมพ์ก่อนส่งพิมพ์ 

  

 

 

5. การออกแบบหนังสือพิมพ์โดยทั่วไป มีการออกแบบอะไรบ้าง ยกตัวอย่างและอธิบาย 

(1) การสร้างสรรค์ลำดับความสำคัญโดยใช้กราฟิก เป็นการสร้างความกลมกลืนทางทัศนศิลป์ รวมทั้งเน้น
ในเรื่องความสมดุล และการตัดกัน  

(2) รูปแบบการจัดองค์ประกอบโดยใช้กราฟิก  ได้แก่ 

ขนาดเล็กไปหาขนาดใหญ่ เพ่ือสร้างจุดสะดุดตาอยู่ด้านล่าง ภาพประกอบขนาดเล็กจะอยู่ส่วนบน 
ดังนั้นรายละเอียดอื่นๆ ของกราฟิก เช่น เนื้อหาต่าง ๆ จะอยู่ตรงกลางหรือทางซ้ายขวา    

 ขนาดใหญ่ไปหาขนาดเล็ก  โดยใช้ภาพขนาดใหญ่อยู่ส่วนบน เพ่ือสร้างความสนใจแก่ผู้อ่านได้ ส่วน
รายละเอียดอ่ืนๆ ก็ทำนองเดียวกันจะอยู่ตรงกลางหรือด้านซ้ายขวา   

แบบแนวนอนไปหาแนวตั้ง เป็นลักษณะของการแบ่งหน้ากระดาษเป็น 2 ส่วน จะได้พ้ืนที่
หน้ากระดาษเป็นแบบสมดุลและไม่สมดุล เมื่อจัดหน้าแบบแนวนอนไปหาแนวตั้ง ด้านบนของ
หน้ากระดาษเป็นลักษณะเปิดกว้าง และด้านล่างจะแคบเป็นแนวตั้ง 

 แบบแนวตั้งไปหาแนวนอน เป็นการออกแบบจัดหน้าตรงข้าม โดยด้านบนของหน้ากระดาษจะเป็น
การแบ่งเป็นแท่งแนวตั้ง ส่วนด้านล่างจะเป็นเนื้อที่กว้าง ผู้อ่านจะถูกกำหนดให้อ่านจากซ้ายไปขวา   

(3) การออกแบบจัดวางตำแหน่งชื่อหนังสือพิมพ์ ควรจะทำให้น่าประทับใจ เรียบง่าย มีความน่าอ่าน 
บริเวณชื่อหนังสือพิมพ์ ควรใช้พ้ืนที่ขาวหรือว่างขาวรอบชื่อหนังสือพิมพ์  ชื่อหนังสือพิมพ์ควรอยู่ด้าน
บนสุดของหน้าหนังสือพิมพ์ และควรใช้ขนาดความยาวตลอดทั้งหน้า คือ ใช้พื้นที่ให้กว้างจากซ้าย
ตลอดไปทางขวามือ เช่น ถ้าหนังสือพิมพ์กว้าง 8 คอลัมน์ ควรวางชื่อหนังสือพิมพ์ตลอด 8 คอลัมน์  
แต่บางฉบับใช้เพียง 2, 3 หรือ 4 คอลัมน์ก็ได้ส่วนที่เหลือเป็นพื้นที่ว่าง 

(4) การออกแบบตำแหน่งคำอธิบายภาพ โดยส่วนใหญ่แล้วจะใช้ 2 บรรทัด นอกจากภาพประกอบที่
ขนาดใหญ่ ซึ่งบรรจุลงในเนื้อที่มากกว่า 3 คอลัมน์  คำอธิบายภาพอาจแบ่งเป็น 2 หรอืมากกว่า 2 



คอลัมน์ การใช้คำอธิบายภาพกับตำแหน่งของภาพควรวางให้ใกล้เคียงกัน คำอธิบายภาพที่ดี ควรวาง
ใต้ภาพ หรืออาจะเป็นด้านซ้าย หรือด้านขวาของภาพ เมื่อใช้ภาพมากกว่า 1 ภาพ ควรแยกคำอธิบาย
แต่ละภาพ ซึ่งผู้อ่านจะได้รับรู้คำอธิบายอย่างทันทีทันใดเกี่ยวกับภาพนั้น โดยไม่จำเป็นต้องกวาด
สายตาไปหาอีกให้เสียเวลา 

(5) การออกแบบวางตำแหน่งชื่อผู้เขียน โดยปกติจะอยู่ระหว่างพาดหัวข่าว และวรรคนำ แต่หนังสือพิมพ์ใน
ประเทศไทยส่วนใหญ่ยังไม่มีการระบุชื่อ ผู้เขียน หรือผู้สื่อข่าว แต่มีแนวโน้มว่าต่อไปจำเป็นต้องมีการ
ระบ ุ ทั้งนี้เพ่ือเป็นการสร้างความน่าเชื่อถือของข่าว ว่าข่าวนั้นบุคคลใดเป็นผู้รายงานข่าว เพราะ
ชื่อเสียงเกียรติประวัติ  การรายงานข่าวจะทำให้ผู้อ่านมีความศรัทธาเชื่อถือเอง 

 (6) การออกแบบวางตำแหน่งชื่อผู้เขียน  ได้แก่  

 ต้นฉบับยาวและการออกแบบแนวนอน เมื่อต้นฉบับมีความยาว ควรใช้การออกแบบแนวนอน จะ
เหมาะสมกว่าแนวดิ่ง เพราะว่าถ้าใช้แนวดิ่งทำให้รู้สึกว่ายาว ไม่น่าอ่าน ผิดกับจัดแนวนอนความรู้สึก
ว่าสั้นกว่า 

 ต้นฉบับยาวและการใช้ขนาดคอลัมน์กว้าง ต้นฉบับที่ยาว หากใช้คอลัมน์ขนาดกว้าง จะใช้เนื้อที่น้อย
กว่าคอลัมน์แคบ และผู้อ่านมีความอยากอ่านคอลัมน์ขนาดกว้างมากกว่าคอลัมน์แคบ 

 ต้นฉบับยาวและการใช้การพักสายตา ต้นฉบับที่ยาว จะทำให้เกิดพ้ืนที่สีเทามากข้ึน ควรใช้สิ่งที่หยุด
ให้พักสายตา ได้แก่ การใช้ “อัญพจน์”  โดยอ้างบางส่วนจากเนื้อหา มาใส่ในอัญประกาศ  ซึ่งอาจวาง
ไว้ตรงกลางคอลัมน์ หรือใต้หัวเรื่อง หรืออาจวางไว้เหนือหัวเรื่องด้านซ้าย หรือขวาได้ 

 

 

 

 

  

 

 

 



แผนจัดการเรียนรู้  วิชา  การใช้โปรแกรมคอมพิวเตอร์กราฟิก        รหัสวิชา 21909-2019 ชั้น ปวช.     
หน่วยที่ 3    เรื่อง   กระบวนการพิมพ์       สัปดาห์ที่  4  เวลา 4   ชัว่โมง 

1. สาระสำคัญ 
ในบทนี ้เราจะเรียนรู้ถึงกระบวนการพิมพ์ ตั้งแต่การจัดเตรียมงานพิมพ์ ไปจนถึงการทำแม่แบบการพิมพ์ 

และการเข้าเล่มในตอนจบงานพิมพ์ ซึ่งกระบวนการที่อยู่ในโรงพิมพ์นั้นเราไม่สามารถเข้าไปดูแลได้ทั้งหมด แต่

สำหรับนักออกแบบกราฟิก จะต้องติดต่อประสานงานกับโรงพิมพ์ ได้แก ่การส่งไฟล์งานพิมพ์ การตรวจงานพิมพ์

หลังจากสร้างแม่พิมพ์เสร็จแล้วก่อนขึ้นแท่นพิมพ์งานทั้งหมด และตรวจการเรียงหน้าก่อนเข้าเล่ม ซึ่งจะแตกต่างกัน

ตามชนิดของงานพิมพ์ 

2 . จุดประสงค์การเรียนรู้ 

1. มีความรู้ และอธิบายจำแนกการเตรียมต้นฉบับก่อนการพิมพ์ได้ 

2. มีความรู้ และอธิบายถึงบริบทเก่ียวกับตัวพิมพ์ได้ 

3. มีความรู้ และอธิบายถึงประเภทของสีได้ 

4. มีความรู้ และอธิบายขั้นตอนและวิธีการแยกสีได้ 

5. มีความรู้ และอธิบายประเภทระบบการพิมพ์ได้ 

6. มีความรู้ และอธิบายบริบทเก่ียวหมึกพิมพ์ได้ 

7. มีความรู้ และอธิบายจำแนกประเภทกระดาษ 

8. มีความรู้ และอธิบายถึงข้ันตอนการทำงานให้แล้วเสร็จได้ 

3. สาระการเรียนรู้ 

1. การเตรียมต้นฉบับก่อนการพิมพ์ 

2. ตัวพิมพ์ 

3. พ้ืนฐานทางสี 

4. การแยกสี 

5. ระบบการพิมพ์  6. หมึกพิมพ์ 

7. กระดาษ    8. การทำให้แล้วเสร็จ 

4. การวัดประเมินผล 



ทักษะพิสัย  มีกระบวนการวางแผน และปฏิบัติได้ตรงตามเป้าหมายที่กำหนด 

พุทธิพิสัย มีความจำ ความเข้าใจ และการนำไปประยุกต์ให้เกิดประโยชน์ต่อการเรียน 

หรือการใช้ชีวิตประจำวัน 

จิตพิสัย ปฏิบัติได้ตามศักยภาพที่มีอยู่ ตรงต่อเวลา และสนใจในการสืบค้นหาความรู้ ทุก

ช่วงโอกาสเพื่อพัฒนาตนเอง 

5.  กิจกรรมการเรียนการสอน 

กิจกรรมครู กิจกรรมนักเรียน 
ขั้นนำเข้าสู่บทเรียน (สัปดาห์ละ 30 นาที) 
1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 

2. ให้นักศึกษาค้นคว้ากระบวนการพิมพ์ 

3. ร่วมสนทนาเกี่ยวกับกระบวนการพิมพ์ 

 

1. ให้ความร่วมมือกับครูในการตรวจสอบ 

2. ค้นคว้าเรื่อง กระบวนการพิมพ์ 

3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน (สัปดาห์ละ 180 นาที) 
1. บอกจุดประสงค์การเรียน 
2. ครูบอกวิธีการ และแนวคิดในการปฏิบัติที่

ถูกต้องให้แก่ผู้เรียน 
3. ประเมินพฤติกรรมรายบุคคลโดยครูจะ

ซักถามในแต่ละคน 

 

1. ฟัง ทำความเข้าใจและซักถาม 
2. แบ่งกลุ่ม 
3. ฟัง ทำความเข้าใจและปฎิบัติตาม 
4. ผู้เรียนซักถามข้อสงสัยและจดบันทึก 
5. รับการประเมิน 

ขั้นสรุป(สัปดาห์ละ 30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. นักเรียนสอบถามข้อสงสัย 
3. ฟังและจดบันทึก 
4. ทำแบบทดสอบท้ายบท 

 

 



6.  กิจกรรมการเรียนรู้ 

 ก่อนเรียน 
 ค้นคว้ากระบวนการพิมพ์ 

ขณะเรียน 
5. แบ่งกลุ่มเพื่อศึกษา 
6. จดบันทึก สาระการเรียนรู้  
7. ทำใบงาน  ตรวจสอบใบงาน แก้ไขใบงาน 
8. ทบทวนเนื้อหา 
หลังเรียน 

5. ร่วมกันสรุปบทเรียน พร้อมบันทึกผลการสรุป แล้วลุกขึ้นนำเสนอกับครูผู้สอน 
6. ผู้เรียนและครูผู้สอนร่วมกันประเมินข้อสรุปของผู้เรียนที่ออกแสดงความคิดเห็นเพ่ือให้ได้ข้อสรุปที่

ถูกต้อง  และครูผู้สอนแสดงความชื่นชมกับผู้เรียนทุกคนที่ออกแสดงความคิดเห็นและมีส่วนร่วมใน
กิจกรรมที่มอบหมาย 

7. ทำแบบฝึกหัดหลังเรียน 
8. ร่วมกันเฉลยแบบฝึกหัด 

 

7. สื่อการเรียนการสอนประจำหน่วย 

7. หนังสือเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิกด้วยคอมพิวเตอร์ 
8. ใบความรู้ประจำหน่วย 
9. ใบงานและแบบฝึกหัด 
10. เครื่องไมโครคอมพิวเตอร์ 
11.  แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 
12. ซีดีสื่อการสอน 

 

 

 



8. วัดผลประเมินผลประจำหน่วย 

4. สังเกตผู้เรียนมีความสนใจ เกิดความเข้าใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน
การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจำหน่วย  

5. ทำใบงานได้อย่างถูกต้อง  ทันเวลาที่กำหนด  ใบงานสะอาดและเป็นระเบียบ 
6. ผู้เรียนทำแบบฝึกหัดหลังเรียนได้ถูกต้อง  โดยได้คะแนน   50%  เป็นอย่างต่ำ 

 

9. กิจกรรมเสนอแนะประจำหน่วย 

5. ผู้เรียนต้องให้ความสนใจในการศึกษา  เพ่ือหาเทคนิค วิธีการ หรือหลักการง่ายเพ่ือให้หาคำตอบได้
อย่างถูกต้อง และรวดเร็ว โดยการ ตั้งใจฟังหลักการ เทคนิควิธีการที่ครูผู้สอนสรุปในขณะที่ทำการสอน และนำข้อ
สงสัยซักถามครูในการเรียนทุกครั้งที่เกิดความสับสน และไม่เข้าใจ 

6. ผู้มีการทบทวนบทเรียน ตลอดเพ่ือเสริมสร้างความเข้าใจอย่างแท้จริง 
7. ผู้เรียนหมั่นทำใบงาน แบบฝึกหัด และแก้ไขข้อที่ผิดให้ถูกต้องเสมอ 
8. ผู้เรียนต้องสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกับความ

จำเป็นในการนำไปประยุกต์ใช้ให้เกิดขึ้นโดยตนเองให้ได้เพ่ือเกิดความรู้ความเข้าใจอย่างแท้จริงไม่ใช่เกิดจากการ
ท่องจำ 

 
 

 

 

 

 

 

 

 



เฉลยแบบฝึกหัด หน่วยที่ 3 

     1.  การเตรียมต้นฉบับก่อนการพิมพ์ มีอะไรบ้าง 

1. การเตรียมต้นฉบับภาพ 

2. การเตรียมต้นฉบับตัวหนังสือ 

3. การถ่ายภาพการพิมพ์   

4. การประกอบหน้า 

 

2.  ตัวพิมพ์ภาษาไทยและภาษาอังกฤษ มีความเหมือน และ/หรือต่างกัน หรือไม ่อย่างไรอธิบาย 

 

 โครงสร้างตัวพิมพ์จะมีแตกต่างกันระหว่างตัวพิมพ์ภาษาอังกฤษกับตัวพิมพ์ภาษาไทย ดังนี้ 

 ภาษาอังกฤษ แบ่งตัวอักษรเป็น 3 ระดับ ได้แก ่ 

 1.  ระดับบนสุด เป็นระดับอักษรตัวพิมพ์เล็กที่มีเส้นหางบน เช่น  b d t h k l t ฯลฯ 

 2.  ระดับกลาง  เป็นระดับ อักษรตัวพิมพ์เล็กที่ไม่มีเส้นหางบนหรือหางล่าง   เช่น  a c e m n o ฯลฯ 

 3.  ระดับล่าง  เป็นระดับตัว อักษรตัวพิมพ์เล็กที่มีเส้นหางล่าง เช่น p q y ฯลฯ สว่นตัวอักษรตัวพิมพ์
ใหญ่มีระดับเดียวกันหมด  

 ภาษาไทย แบ่งตัวอักษรเป็น 4 ระดับ ได้แก่  

 1.  ระดับบนสุด  เป็นระดับวรรณยุกต์ เช่น  ่   ้   ๊  ๋  ฯลฯ  

2.  ระดับพยัญชนะท่ีมีหางบน ระดับสระอยู่ด้านบน และสระที่มีหางบน เช่น ช ซ ป ฝ ฟ ศ ศ ส ฬ ฮ โ ไ ใ    
ิ    ี    ึ    ื ฯลฯ  

 3.  ระดับพยัญชนะและสระที่เสมอบรรทัด หรือไม่มีหางบนหรือล่าง เช่น ก ข ค ง ะ า เ  แ ฯลฯ  

 4.  ระดับพยัญชนะที่มีหางล่างและสระที่อยู่ด้านล่าง เช่น ญ ฎ ฐ   ุ   ู ฯลฯ 

 

3.  สี มีก่ีประเภท อะไรบ้าง สีในการพิมพ์ คือ ประเภทใด 

 สีมี 2 ประเภท ได้แก่  แม่สีบวกและแม่สีลบ สีที่ใช้ในการพิมพ์ คือ สีลบ 



 

4. จงบอกขั้นตอนและวิธีการแยกสีที่จะทำแม่พิมพ์ ทั้ง 4 สีอย่างละเอียด 

 ในการแยกสีจะอาศัยหลักการผสมสีทั้งแม่สีบวกและแม่สีลบ มาประยุกต์เป็นแว่นกรองแสง เพ่ือเป็นแว่น
กรองสี และมุมเม็ดสกรีน โดยการถ่ายฟิล์มนั้น จะต้องทำการถ่าย 4 ครั้ง ดังนี้   

1. ถ่ายครั้งที ่1 เพ่ือให้ได้ฟิล์มสำหรับแม่พิมพ์สีเหลือง (Yellow plate) ให้ใช้แว่นสีน้ำเงิน (Blue filter) 
และใช้มุมของเม็ดสกรีน 10 องศา 

2. ถ่ายครั้งที่ 2 เพ่ือให้ได้ฟิล์มสำหรับแม่พิมพ์สีบานเย็น (Magenta plate) ให้ใช้แว่นสีเขียว (Green 
filter) และใช้มุมของเม็ดสกรีน 75 องศา 

3. ถ่ายครั้งที ่ 3 เพ่ือให้ได้ฟิล์ม สำหรับสีฟ้า (Cyan plate) ให้ใช้แว่นสีแดง (Red filter) และใช้มุมของ
เม็ดสกรีน 105 องศา 

4. ถ่ายครั้งที ่ 4 เพ่ือให้ได้ฟิล์ม สำหรับสีดำให้ (ฺBlack plate) ใช้แว่นทุกสีพร้อมกัน และมุมของเม็ด
สกรีน 45 องศา 

  

5. ระบบการพิมพ์มีอะไรบ้าง 

การพิมพ์แม่พิมพ์พ้ืนนูน (Letter press), การพิมพ์แม่พิมพ์พ้ืนลึก, การพิมพ์แม่พิมพ์พ้ืนราบ, การพิมพ์
แม่พิมพ์พ้ืนฉลุ  และการพิมพ์ไร้แรงกด   

 

6. หมึกพิมพ์มีคุณสมบัติอะไรบ้าง มีการแห้งกี่แบบ 

คุณสมบัติของหมึกพิมพ์มี 3 ประการ ได้แก ่ความเหนียว (Viscosity) , การติดแน่น (Tack)  และลักษณะ
การแห้ง (Drying quality) 

 การแห้งมี  4 วิธี ได้แก ่ 

 การระเหย (Evaporation) ส่วนมากใช้หมึกเหลวและจางในการพิมพ์กราเวียร์เพ่ือให้หมึกแห้งเร็ว  

การอบด้วยสารเคมี (Chemical curing) การเติมสารเร่งปฏิกิริยาทางเคมีเข้าในหมึกก่อนเริ่มพิมพ์ มีวิธี
อบที่คล้ายกัน คือ อบด้วยแสงอุลต้าไวโอเลต (Ultraviolet light)  

การซึมซับ (Penetration) เป็นหมึกพิมพ์กับกระดาษท้ังหลายที่ดูดซึมซับได้ดี แต่ไม่เหมาะกับการพิมพ์บน
ขวด พลาสติก หรือฟอยด์  



การจับก้อนด้วยการอ๊อกซิเดชัน (oxidation) เป็นการแห้งด้วยการดูดอากาศออกซิเจนเข้ามาจะทำให้อนู
ของหมึกจับกันเป็นก้อนแข็ง เพ่ือยึดติดกับวัสดุที่พิมพ์ แต่เป็นกระบวนที่เป็นไปอย่างช้า ๆ  

 

7. กระดาษมีการพิจารณาความหนาอย่างไร 

ใช้น้ำหนักเป็นตัวบ่งชี้ความหนา ถ้าน้ำหนักมาก หมายถึง กระดาษมีความหนามาก กล่าวคือ ใช้กระดาษ
ขนาดหนึ่งตารางเมตร ชั่งดูว่าหนักท่าไร เช่น น้ำหนัก 70 กรัม 80 กรัม แสดงว่ากระดาษ 80 กรัมหนากว่า 
70 กรัมเพราะน้ำหนักมากกว่า 

 

8. ขั้นตอนการทำงานพิมพ์ให้แล้วเสร็จ มีอะไรบ้าง 
 เป็นขั้นตอนสุดท้ายในการปิดงาน ได้แก ่การพับ การเข้าเล่ม การเย็บเล่มและการเข้าปก 

 

 

 

 

 

 

 

 

 

 

 

 



แผนจัดการเรียนรู้    วิชา   การใช้โปรแกรมคอมพิวเตอร์กราฟิก          รหัสวิชา   21909-2019    ชั้น   ปวช. 

หน่วยที่ 4    เรื่อง   รู้จักกับโปรแกรม InDesign                    สัปดาห์ท่ี   5   เวลา   4   ชั่วโมง  

 

1.  สาระสำคัญ 

งานด้านสื่อสิ่งพิมพ์ต่างๆ เช่น นิตยสาร วารสาร โบรชัวร์หรือแผ่นพับ และหนังสือประเภทต่างๆ ที่มีอยู่ใน
ปัจจุบันนั้น มีความเก่ียวข้องกับโปรแกรม Adobe photoshop ซึ่งเป็นโปรแกรมที่สามารถออกแบบและ
สร้างสรรค์ผลงานสิ่งพิมพ์เหล่านี้ได้อย่างรวดเร็วและมีประสิทธิภาพ 

  
2. ผลการเรียนรู้ที่คาดหวัง 

1. รู้และเข้าใจในโปรแกรม Adobe photoshop 
2. อธิบายการเข้าสู่โปรแกรม Adobe photoshop ได้ 
3. อธิบายเกี่ยวกับแถบคำสั่งของโปรแกรม Adobe photoshop ได้ 
4. อธิบายเกี่ยวกับกล่องเครื่องมือของโปรแกรม Adobe photoshop ได ้
5. อธิบายเกี่ยวกับคอนโทรลพาเนลของโปรแกรม Adobe photoshop ได้ 
6. อธิบายเกี่ยวกับพาเนลควบคุมการทำงานได้ 
7. สามารถจัดการกับหน้าต่างการทำงานได้ 
8. สามารถกำหนดคีย์ลัดได้ 
9. อธิบายเกี่ยวกับโปรแกรมช่วยจัดการข้อความภาษาไทยได้ 

 

 

 

 

 

 



3.  กิจกรรมการเรียนรู้ 

กิจกรรมครู กิจกรรมผู้เรียน 
ขั้นนำเข้าสู่บทเรียน(30 นาที) 

1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 
2. ให้นักศึกษาค้นคว้าคำเก่ียวกับความสามารถ 
    โดยรวมของโปรแกรม  InDesign 
3. ร่วมสนทนาเกี่ยวกับเรื่อง InDesign 

 

1. ให้ความร่วมมือกับครูในการตรวจสอบ 

2. ค้นคว้า 

3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน(180 นาที) 
1. บอกจุดประสงค์การเรียน 
2. บรรยาย อธิบาย ยกตัวอย่าง แสดงวิธีการปฎิบัติ
ในแต่ละหัวข้อการเรืยนและให้นักศึกษาปฎิบัติไป
พร้อมกัน  
3. ให้คำแนะนำ  
4. ประเมินพฤติกรรมรายบุคคลโดยอาจารย์จะ
ซักถามในแต่ละบุคคล 

 
1. ฟัง ทำความเข้าใจและซักถาม 
2. ฟัง ทำความเข้าใจและปฎิบัติตาม 
3. ผู้เรียนซักถามข้อสงสัย 
4. รับการประเมิน 
 

ขั้นสรุป(30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. นักเรียนสอบถามข้อสงสัย 
3. ฟังและจดบันทึก 
4. ทำแบบทดสอบท้ายบท 

 

4.   กิจกรรมการเรียนรู้ 

 ก่อนเรียน 
1. ค้นคว้าคำเก่ียวกับความสามารถโดยรวมของโปรแกรม  InDesign 
 ขณะเรียน 

1. ทำความเข้าใจและปฎิบัติตามในแต่ละหัวข้อการเรืยน 



2. ทำใบงานและแบบฝึกหัดหลังเรียน 

3. ร่วมกันเฉลยใบงานและแบบฝึกหัดหลังเรียน 

4. จดบันทึก เทคนิค แนวการที่เป็นประโยชน์ต่อผู้เรียน จากข้อแนะนำของครูผู้สอน 

5. ผู้เรียนสรุปความรู้ที่ได้จากการเรียนตามความเป็นจริง จากภูมิความรู้ของผู้เรียนแต่ละคน 

6. ผู้เรียนซักถามในหัวข้อที่สงสัยในเนื้อหาการเรียนรู้ 

 

5.  สื่อการเรียนการสอน 

1. หนังสือประกอบการเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก     

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจำหน่วย 

4. เครื่องไมโครคอมพิวเตอร์ 

5. แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 

6. ซีดีสื่อการสอนเรื่องระบบฐานข้อมูล 

 

6. วัดผลประเมินผล 

1. ผู้เรียนปฏิบัติภาระงานที่มอบหมายเสร็จทันเวลาที่กำหนด 

2. ตอบคำถามและสรุปผลงานได้อย่างถูกต้อง 

3. ทำแบบฝึกหัดหลังเรียนเสร็จทันเวลาที่กำหนดและถูกต้อง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบคำถาม สรุปสาระการเรียนรู้ และกล้าแสดงความคิดเห็น 

 

7.   กิจกรรมเสนอแนะ 

ถ้าผู้เรียนมีการเตรียมตัวในการเรียนที่ดี เช่น อ่าน และทำการศึกษาหนังสือเกี่ยวกับหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผู้เรียน จะสามารถเรียน และทำกิจกรรมต่าง ๆ ที่ครูผู้สอนมอบหมาย ได้อย่างมีความสุข และ
เกิดความชอบ และสนุกกับการเรียนในชั้นเรียน 



 

เฉลยแบบฝึกหัดหน่วยท่ี  4 

ตอนที่ 1 จงตอบคำถามต่อไปนี้ 

1. การเตรียมเครื่องคอมพิวเตอร์เพื่อติดตั้งโปรแกรม InDesign มีอะไรบ้าง 

1.  ซีพียู Intel Pentium 4, Intel Core Duo หรือมีคุณสมบัติเทียบเท่า 

2.  ระบบปฏิบัติการ Windows XP  Service Pack 2 ขึ้นไป หรือ Windows 7 

3.  หน่วยความจำ 512 MB ขึ้นไปสำหรับ Windows XP และ 1 GB ขึ้นไปสำหรับ Windows 7 

4.  พ้ืนที่บนฮาร์ดดิสก์ 1.8 GB สำหรับการติดตั้งโปรแกรม (เพ่ือประสิทธิภาพการทำงานที่ดีขึ้นควรมีพ้ืนที่ 

     4 GB ขึ้นไป) 

 

2. Menu Bar ในโปรแกรม InDesign มีอะไรบ้าง จงอธิบายมาพอเข้าใจ 

 file เป็นคำสั่งการทำงานเกี่ยวกับไฟล์ เช่น การเปิดไฟล์ (Open), ปิดไฟล์ (Close),  การบันทึกไฟล์  

  (Save) นอกจากนี้ยังเกี่ยวข้องกับการนำไฟล์เข้ามาใช้ (Place) และกำหนดคุณสมบัติของไฟล์  

  (Document Setup) 

 Edit เป็นคำสั่งเกี่ยวกับการปรับแต่งต่างๆ เช่น การย้อนกลับการทำงาน (Undo/Redo), การตัด 
(Cut),  

  การทำสำเนาหรือคัดลอก (Copy), การวาง (Paste) และการกำหนดค่าการทำงานพ้ืนฐานของ 

  โปรแกรม (Preference)   

 Layout เป็นคำสั่งที่เกี่ยวกับการวางหน้าเอกสารทั้งหมด เช่น เพ่ิมหน้าเอกสาร (Add Page), กำหนด 

  ระยะเส้นไกด ์และจัดคอลัมน์ (Magins & Columns), เลื่อนไปยังหน้าต่างๆ (Go to page),  

  การกำหนดเลขหน้า (Numbering & Section options) 

 Type เป็นคำสั่งที่เกี่ยวกับการทำงานกับตัวอักษร  

Object เป็นคำสั่งเกี่ยวกับการจัดการออบเจ็กต์ท้ังหมด เช่น คำสั่งในการจัดกลุ่ม (Group), การจัดลำดับ  



 (Arrange) และการปรับแต่ง (Transform) รวมไปถึงการใส่เอฟเฟ็กต์เพ่ิมเติม 

 Table  เป็นคำสั่งเกี่ยวกับการใช้งานตาราง ตั้งแต่การสร้าง และการปรับแต่งรูปแบบของตาราง 

 View  กำหนดมุมมองการแสดงภาพในรูปแบบต่างๆ เช่น การขยายดูภาพใกล้ๆ  

 Window จัดการแต่ละหน้าต่างที่ปรากฏบนหน้าจอของโปรแกรม เพ่ือช่วยให้ทำงานได้สะดวกข้ึน 

 Help  รวบรวมวิธีการใช้งานและคำแนะนำเกี่ยวกับโปรแกรม Adobe photoshop 

 

3. จงอธิบายวิธีการสร้างและลบคีย์ลัดมาพอเข้าใจ 

วิธีการสร้างคีย์ลัด 

1. เลือกคำสั่ง Edit->Keyboard Shortcuts... 

2. สร้างชุดคีย์ลัดขึ้นมาใหม่ โดยคลิกปุ่ม New Set... 

3. ตั้งชื่อให้กับชุดคีย์ลัดใหม่ที่สร้างในช่อง Name และเลือกกำหนดชุดคีย์ลัดอ้างอิงที่ Based on Set เพ่ือใช้ 

  เป็นคีย์ลัดต้นแบบของคีย์ลัดที่เราสร้างข้ึน 

4. คลิกปุ่ม OK ชื่อของชุดคีย์ลัดที่สร้างจะปรากฏอยู่ท่ีหัวข้อ Set ในหน้าต่าง Keyboard Shortcuts 

5. เลือกคำสั่งที่ต้องการสร้างคีย์ลัดที่ช่อง Command ซึ่งจะปรากฏคีย์ลัดเดิมที่ช่อง Current Shotcuts  

6. คลิกเมาส์เลือกท่ี New Shortcut และกดคีย์ที่ต้องการตั้งเป็นคีย์ลัด ตัวอย่างกำหนดเป็นปุ่ม 1 

7. เมื่อกำหนดคีย์ลัดต่างๆ เรียบร้อยคลิกปุ่ม OK เพ่ือตกลงใช้งานตามค่าที่ตั้งไว้ 

วิธีการลบคีย์ลัด 

1. เลือกคำสั่ง Edit->Keyboard Shortcuts... 

2. คลิกเลือกชื่อของชุดคีย์ลัดที่ต้องการลบ 

3. คลิกเมาส์ที่ปุ่ม Delete Set 

4. ปรากฏหน้าต่างถามว่า ต้องการลบคีย์ลัดที่เราเลือกไว้หรือไม่ คลิกท่ี Yes 

 

4. การใช้งานโปรแกรม Kokai ร่วมกับ InDesign มีข้ันตอนอย่างไร จงอธิบาย 

1.ดับเบ้ิลคลิกท่ีไอคอนโปรแกรม Kokai บนหน้าเดสก์ท็อป เพ่ือเปิดใช้งานโปรแกรมก่อนที่จะเปิด 



  โปรแกรม InDesign 

2. เปิดโปรแกรม InDesign ขึ้นมา โปรแกรม Kokai จะทำงานร่วมกับ InDesign ทันท ีเพ่ือช่วยในการตัดคำ  

   และแก้ปญัหาสระลอยในการใช้งานตัวอักษรภาษาไทย  

3. เมื่อต้องการเลิกใช้งานโปรแกรม ต้องปิดโปรแกรม InDesign ก่อนที่จะปิดโปรแกรม Kokai ทุกครั้ง                 
 

5. จงบอกส่วนประกอบของหน้าจอโปรแกรม InDesign 

 

5.1 คือ สัญลักษณ์ของโปรแกรม InDesign 

5.2 คือ แถบคำสั่ง (Menu Bar) 

5.3 คือ แถบคอนโทรลพาเนล (Control Panel) 

5.4 คือ พาเนลต่างๆ (Dock Panel) ที่รวบรวมคุณสมบัติการทำงาน 



5.5 คือ กล่องเครื่องมือ (Tool Box) 
5.6 คือ พ้ืนที่การทำงาน (Art Board) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



แผนจัดการเรียนรู้    วิชา   การใช้โปรแกรมคอมพิวเตอร์กราฟิก         รหัสวิชา   21909-2019    ชั้น   ปวช. 

หน่วยที่ 5    การจัดการไฟล์งานและเครื่องมือพื้นฐาน                   สัปดาห์ท่ี   6   เวลา   4   ชั่วโมง  

 

1.  สาระสำคัญ 

 เป็นการเรียนรู้เกี่ยวกับการจัดการกับชิ้นงาน ตั้งแต่ขั้นตอนในการสร้างไฟล์งาน, การเปิดไฟล์งาน, การ
บันทึกไฟล์งาน และการปิดไฟล์งาน รวมถึงการเพ่ิม และการลดจำนวนหน้า ซึ่งเป็นการจัดการขั้นพ้ืนฐานกับ
ไฟล์งาน 

  
 
2. ผลการเรียนรู้ที่คาดหวัง 

1. อธิบายเกี่ยวกับเรื่องการสร้างไฟล์งานได้ 
2. สามารถบันทึกไฟล์งานได้ 
3. อธิบายเกี่ยวกับการปิดไฟล์งานได้ 
4. สามารถเปิดไฟล์งานเดิมได้ 
5. สามารถเพ่ิมและลดจำนวนหน้าได้ 
6. สามารถทำการย้ายหน้ากระดาษได้ 
7. อธิบายการย่อและขยายมุมมองได้ 
8. สามารถใช้คำสั่งยกเลิก Undo/Revert ได้ 
9.   อธิบายการใช้งานเครื่องมือวัดได้ 

 

 

 

 

 



3.  กิจกรรมการเรียนรู้ 

กิจกรรมครู กิจกรรมผู้เรียน 
ขั้นนำเข้าสู่บทเรียน(30 นาที) 

1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 
2. ให้นักศึกษาค้นคว้าคำเก่ียวกับความสามารถ 
    โดยรวมของการจัดการไฟล์งานและเครื่องมือ 
    พ้ืนฐาน                  
3. ร่วมสนทนาเกี่ยวกับเรื่องการจัดการไฟล์งานและ 
    เครื่องมือพ้ืนฐาน 

 

1. ให้ความร่วมมือกับครูในการตรวจสอบ 

2. ค้นคว้า 

3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน(180 นาที) 
1. บอกจุดประสงค์การเรียน 
2. บรรยาย อธิบาย ยกตัวอย่าง แสดงวิธีการปฎิบัติ
ในแต่ละหัวข้อการเรืยนและให้นักศึกษาปฎิบัติไป
พร้อมกัน  
3. ให้คำแนะนำ  
4. ประเมินพฤติกรรมรายบุคคลโดยอาจารย์จะ
ซักถามในแต่ละบุคคล 

 
1. ฟัง ทำความเข้าใจและซักถาม 
2. ฟัง ทำความเข้าใจและปฎิบัติตาม 
3. ผู้เรียนซักถามข้อสงสัย 
4. รับการประเมิน 
 

ขั้นสรุป(30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. นักเรียนสอบถามข้อสงสัย 
3. ฟังและจดบันทึก 
4. ทำแบบทดสอบท้ายบท 

 

4.   กิจกรรมการเรียนรู้ 

 ก่อนเรียน 
1. ค้นคว้าคำเก่ียวกับความสามารถโดยรวมของการจัดการไฟล์งานและเครื่องมือพ้ืนฐาน 

 ขณะเรียน 



1. ทำความเข้าใจและปฎิบัติตามในแต่ละหัวข้อการเรืยน 

2. ทำใบงานและแบบฝึกหัดหลังเรียน 

3. ร่วมกันเฉลยใบงานและแบบฝึกหัดหลังเรียน 

4. จดบันทึก เทคนิค แนวการที่เป็นประโยชน์ต่อผู้เรียน จากข้อแนะนำของครูผู้สอน 

5. ผู้เรียนสรุปความรู้ที่ได้จากการเรียนตามความเป็นจริง จากภูมิความรู้ของผู้เรียนแต่ละคน 

6. ผู้เรียนซักถามในหัวข้อที่สงสัยในเนื้อหาการเรียนรู้ 

 

5.  สื่อการเรียนการสอน 

1. หนังสือประกอบการเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก     

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจำหน่วย 

4. เครื่องไมโครคอมพิวเตอร์ 

5. แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 

6. ซีดีสื่อการสอนเรื่องระบบฐานข้อมูล 

 

6. วัดผลประเมินผล 

1. ผู้เรียนปฏิบัติภาระงานที่มอบหมายเสร็จทันเวลาที่กำหนด 

2. ตอบคำถามและสรุปผลงานได้อย่างถูกต้อง 

3. ทำแบบฝึกหัดหลังเรียนเสร็จทันเวลาที่กำหนดและถูกต้อง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบคำถาม สรุปสาระการเรียนรู้ และกล้าแสดงความคิดเห็น 

 

 

 

 



7.   กิจกรรมเสนอแนะ 

ถ้าผู้เรียนมีการเตรียมตัวในการเรียนที่ดี เช่น อ่าน และทำการศึกษาหนังสือเกี่ยวกับหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผู้เรียน จะสามารถเรียน และทำกิจกรรมต่าง ๆ ที่ครูผู้สอนมอบหมาย ได้อย่างมีความสุข และ
เกิดความชอบ และสนุกกับการเรียนในชั้นเรียน 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



เฉลยแบบฝึกหัดหน่วยท่ี  5 

ตอนที่ 1 จงตอบคำถามต่อไปนี้ 

1. จงบอกขั้นตอนการสร้างไฟล์งาน โดยใช้ Template 

 1. คลิกท่ี Start->All Programs->Adobe photoshop เพ่ือเปิดโปรแกรม Adobe photoshop  

 2. คลิกท่ีเมนู File->New->Document from Template เพ่ือเปิดหน้าต่าง Templates ขึ้นมา  

 3. ปรากฏหน้าต่าง Adobe Bridge คลิกเลืิอกหมวดหมู่งานพิมพ์ในโฟลเดอร์ที่ต้องการจากแท็บ Content  

    ได้แก่ Book, Brochures, Business Sets, Catalog, Cd-Dvd, Certificate, Community, 
Newspaper และ 

    อ่ืนๆ   

 4. คลิกเลือกรูปแบบงานพิมพ์ที่ต้องการ 

 5. ปรากฏไฟล์งานพิมพ์ที่เป็นใบงานนำเสนอ ดับเบ้ิลคลิกเพ่ือเปิดชิน้งานตัวอย่างท่ีต้องการข้ึนมาใช้งาน  

 

2. คำสั่งที่ใช้ในการย่อ-ขยายมีอะไรบ้าง และมีความหมายอย่างไร 

 Zoom In   ขยายมุมมองของหน้ากระดาษให้เพิ่มข้ึน 1 ขั้น เช่น จากเดิม 50% จะ
เพ่ิมข้ึน  

    เป็น 75% 

 Zoom Out  ลดมุมมองของหน้ากระดาษลง 1 ขั้น เช่น จากเดิม 50% จะลดลงเป็น 25% 

 Fit Page in Window แสดงมุมมองของหน้ากระดาษเดี่ยว (Page) ให้มีขนาดพอดีกับ  
    หน้าต่างโปรแกรม 

 Fit Spread in Window แสดงมุมมองของหน้ากระดาษคู่ (Spread) ให้มีขนาดพอดีกับ   
   หน้าต่างโปรแกรม 

 Actual Size  แสดงมุมมองของหน้ากระดาษท่ีระยะ 100% 

 Entire Pasteboard   แสดงองค์ประกอบทั้งหมดในงานพิมพ์ รวมทั้งพ้ืนที่รอบข้างทั้งหมด 

 



 

3. การยกเลิกการกระทำท่ีไม่ต้องการมีกี่แบบ อะไรบ้าง 

มี 2 แบบ คือ 

1. ยกเลิกการกระทำครั้งล่าสุดด้วยคำสั่ง Undo 

โปรแกรมจดจำการกระทำครั้งล่าสุดเอาไว้ เราสามารถยกเลิกการกระทำครั้งล่าสุดได้โดยใช้คำสั่ง Undo แต่
คำสั่ง Undo จะเปลี่ยนไปตามการกระทำที่เราได้ทำลงไป เช่นหากเราลบอะไรไป ก็จะปรากฏคำสั่ง Undo Clear 
แต่หากเราพิมพ์หรือแก้ไขข้อความใดๆ ก็จะปรากฏเป็น Undo Typing 

2. ยกเลิกการกระทำหลังการบันทึกไฟล์ 

เมื่อเราแก้ไขงานพิมพ์ไปแล้วรู้สึกไม่ชอบ  เราสามารถยกเลิกการกระทำทั้งหมดที่เกิดขึ้นหลังการบันทึกไฟล์
งานพิมพ์นี้ โดยใช้คำสั่ง Revert เพ่ือให้งานพิมพ์กลับไปเหมือนกับตอนที่ได้บันทึกไว้ครั้งล่าสุด 
 

4. เส้นไกด์มีทั้งหมดก่ีชนิด อะไรบ้าง 

ชนิดของเส้นไกด์มีทั้งหมด 3 ชนิดได้แก ่ 

1.  เส้นไกด์ท่ีเกิดจากระยะห่างจากขอบกระดาษ (Margin guide) 

2.  เส้นไกด์ท่ีเกิดจากการแบ่งคอลัมน์ (Column guide) 

3.  เส้นไกด์ท่ีสร้างขึ้นจากแถบไม้บรรทัด (Ruler guide)  

 

5. เส้นไกด์ท่ีเกิดจากการแบ่งคอลัมน์คืออะไร มีข้ันตอนในการสร้างอย่างไร 

คือเส้นไกด์ท่ีใช้แบ่งหน้ากระดาษออกเป็นหลายคอลัมน์ เพ่ือช่วยในการแบ่งขอบเขตในการจัดวางเนื้อหาทั้ง
ข้อความ และภาพใช้ควบคุมการไหลของข้อความที่เป็น Text blocks โดยมีขั้นตอนในการสร้าง ดังนี้ 

1. คลิกเลือกแท็บ Pages Panel แล้วคลิกเลือกหน้ากระดาษท่ีต้องการแบ่งคอลัมน์ 

2. เลือกคำสั่ง Layout->Margins and Columns 

3. ปรากฏหน้าต่าง Margins and Columns จากนั้นให้เรากำหนดจำนวนของคอลัมน์ในช่อง Number และ 

    ระยะห่างของของคอลัมน์ในช่อง Gutter (จากตัวอย่างจะเป็นการกำหนดคอลัมน์ของงานพิมพ์หน้าคู่ ซึ่ง 



    กำหนดจำนวนคอลัมน์ 3 คอลัมน์และกำหนดระยะห่างของคอลัมน์เท่ากับ 0.25 นิ้ว) 

 Number : จำนวนของคอลัมน์ที่เราต้องการ 

 Gutter : ระยะห่างที่เป็นช่องว่างระหว่างคอลัมน์ 

4. คลิกเมาส์ที่ปุ่ม OK เพ่ือตกลงใช้ค่าที่กำหนด 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



แผนจัดการเรียนรู้    วิชา   การใช้โปรแกรมคอมพิวเตอร์กราฟิก        รหัสวิชา   21909-2019    ชั้น   ปวช. 

หน่วยที่ 6    การทำงานกับข้อความ    สัปดาห์ท่ี   7-8   เวลา  8   ชั่วโมง  

 

1.  สาระสำคัญ 

 เรียนรู้การทำงานกับข้อความในขั้นพ้ืนฐาน เป็นส่วนที่สำคัอย่างมากในการสร้างงานพิมพ์ โดยเริ่มเรียนรู้
ตั้งแต่การสร้างข้อความ และการทำงานกับข้อความที่สร้างไว้  
 
2. ผลการเรียนรู้ที่คาดหวัง 

1. อธิบายการสร้างข้อความประเภทต่างๆ ได้ 

2. บอกเกี่ยวกับการปรับแต่งข้อความแบบ Type on Path ได้ 

3. รู้จักเกี่ยวกับข้อความใน Adobe photoshop 

4. สามารถคัดลอกข้อความจากไฟล์โปรแกรมอ่ืนๆ มาใช้งานได้ 

5. อธิบายการไหลของข้อความได้ 

6. อธิบายเกี่ยวกับการใช้คอลัมน์ได้ 

7. สามารถตัดและรวมข้อความได้ 
8. สามารถแก้ไขข้อความในพ้ืนที่ Story Editor ได ้

 

 

 

 

 

 



3.  กิจกรรมการเรียนรู้ 

กิจกรรมครู กิจกรรมผู้เรียน 
ขั้นนำเข้าสู่บทเรียน(30 นาที) 

1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 
2. ให้นักศึกษาค้นคว้าคำเกี่ยวกับการทำงานกับ
ข้อความ 
3. ร่วมสนทนาเกี่ยวกับเรื่องการทำงานกับข้อความ 
 

 

1. ให้ความร่วมมือกับครูในการตรวจสอบ 

2. ค้นคว้า 

3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน(180 นาที) 
1. บอกจุดประสงค์การเรียน 
2. บรรยาย อธิบาย ยกตัวอย่าง แสดงวิธีการปฎิบัติ
ในแต่ละหัวข้อการเรืยนและให้นักศึกษาปฎิบัติไป
พร้อมกัน  
3. ให้คำแนะนำ  
4. ประเมินพฤติกรรมรายบุคคลโดยอาจารย์จะ
ซักถามในแต่ละบุคคล 

 
1. ฟัง ทำความเข้าใจและซักถาม 
2. ฟัง ทำความเข้าใจและปฎิบัติตาม 
3. ผู้เรียนซักถามข้อสงสัย 
4. รับการประเมิน 
 

ขั้นสรุป(30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. นักเรียนสอบถามข้อสงสัย 
3. ฟังและจดบันทึก 
4. ทำแบบทดสอบท้ายบท 

 

4.   กิจกรรมการเรียนรู้ 

ก่อนเรียน 
1. ค้นคว้าคำเก่ียวกับการทำงานกับข้อความ 
 
 
 



 ขณะเรียน 
1. ทำความเข้าใจและปฎิบัติตามในแต่ละหัวข้อการเรืยน 

2. ทำใบงานและแบบฝึกหัดหลังเรียน 

3. ร่วมกันเฉลยใบงานและแบบฝึกหัดหลังเรียน 

4. จดบันทึก เทคนิค แนวการที่เป็นประโยชน์ต่อผู้เรียน จากข้อแนะนำของครูผู้สอน 

5. ผู้เรียนสรุปความรู้ที่ได้จากการเรียนตามความเป็นจริง จากภูมิความรู้ของผู้เรียนแต่ละคน 

6. ผู้เรียนซักถามในหัวข้อที่สงสัยในเนื้อหาการเรียนรู้ 

 

5.  สื่อการเรียนการสอน 

1. หนังสือประกอบการเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก 

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจำหน่วย 

4. เครื่องไมโครคอมพิวเตอร์ 

5. แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 

6. ซีดีสื่อการสอนเรื่องระบบฐานข้อมูล 

 

6. วัดผลประเมินผล 

1. ผู้เรียนปฏิบัติภาระงานที่มอบหมายเสร็จทันเวลาที่กำหนด 

2. ตอบคำถามและสรุปผลงานได้อย่างถูกต้อง 

3. ทำแบบฝึกหัดหลังเรียนเสร็จทันเวลาที่กำหนดและถูกต้อง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบคำถาม สรุปสาระการเรียนรู้ และกล้าแสดงความคิดเห็น 

 

7.   กิจกรรมเสนอแนะ 



ถ้าผู้เรียนมีการเตรียมตัวในการเรียนที่ดี เช่น อ่าน และทำการศึกษาหนังสือเกี่ยวกับหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผู้เรียน จะสามารถเรียน และทำกิจกรรมต่าง ๆ ที่ครูผู้สอนมอบหมาย ได้อย่างมีความสุข และ
เกิดความชอบ และสนุกกับการเรียนในชั้นเรียน 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



เฉลยแบบฝึกหัดหน่วยท่ี  6 

ตอนที ่2 จงทำเครื่องหมาย  ล้อมรอบตัวเลือกท่ีถูกต้องที่สุด 

1. ข้อใดคือรูปแบบของข้อความในโปรแกรม InDesign 

ก. Text Form   ข. Text Block 

ค. Text Book   ง. Text Box 

 

2. ข้อใดไม่ใช่รูปแบบของ Frame Tool 

ก. Rectangle Tool  ข. Polygon Frame Tool 

ค. Ellipse Frame Tool  ง. Rectangle Frame Tool 

 

3. การใช้เมาส์คลิกที่เส้นตั้งฉาก  บนเส้นพาธตรงกลางข้อความ และคลิกลากไปอีกด้านของพาธ  

หมายถึงการกระทำใด 

ก. ดึงข้อความ   ข. แก้ไขข้อความ 

ค. วางข้อความ   ง. พลิกกลับข้อความ 

 

4. การจัดวางตัวอักษรให้ตั้งตรง ไม่เอียงตามเส้นพาธ หมายถึงคำสั่งใดในหน้าต่าง Type on a Path  

Options 

ก. Skew   ข. Gravity 

ค. 3D Ribbon   ง. Rainbow 

 

5. การจัดวางตัวอักษรให้บิดเอียงดูมีมิติ หมายถึงคำสั่งใดในหน้าต่าง Type on a Path Options 

ก. Skew   ข. Gravity 

ค. 3D Ribbon   ง. Rainbow 

 



6. เป็นการจัดวางตัวอักษรให้เอียง และตั้งฉากสัมพันธ์กับความโค้งของเส้นพาธ หมายถึงคำสั่งใดในหน้าต่าง 
Type on a Path Options 

ก. Skew   ข. Gravity 

ค. 3D Ribbon   ง. Rainbow 

 

7. การเลือกข้อความโดยใช้  Selection Tool หมายถึงข้อใด 

ก. ข้อความในสถานะพ้ืนหลัง ข. ข้อความในสถานะรูปภาพ 

ค. ข้อความในสถานะตัวอักษร ง. ข้อความในสถานะวัตถุ 

 

8. การเลือกข้อความโดยใช้   Type Tool หมายถึงข้อใด 

ก. ข้อความในสถานะวัตถุ  ข. ข้อความในสถานะตัวอักษร 

ค. ข้อความในสถานะรูปภาพ  ง. ข้อความในสถานะพื้นหลัง 

 

9.  ปุ่ม  ในคำสั่งกำหนดขอบเขตการค้นหา หมายถึงข้อใด 

ก. ค้นหาแบบแยกตัวพิมพ์ใหญ่เล็ก 

ข. ค้นหาคำในส่วนเชิงอรรถ 

ค. ค้นหาคำในกรอบข้อความที่ถูกล็อก 

ง. ค้นหาคำโดด ค้นหาเป็นคำ 

10.  ปุ่ม   ในคำสั่งกำหนดขอบเขตการค้นหา หมายถึงข้อใด 

ก. ค้นหาคำในเลเยอร์ที่ถูกล็อก 

ข. ค้นหาคำในกรอบข้อความที่ถูกล็อก 

ค. ค้นหาคำในเลเยอร์ที่ถูกซ่อน 

ง. ค้นหาคำในส่วนเชิงอรรถ 

ตอนที ่2 จงตอบคำถามต่อไปนี้ 



 

1. รูปแบบของข้อความในโปรแกรม InDesign มีกี่ประเภท อะไรบ้างจงอธิบาย 

รูปแบบของข้อความในโปรแกรม InDesign มี 2 ประเภท คือ 

1. Text block เป็นข้อความเกือบทั้งหมดที่อยู่ในงามพิมพ์ที่สร้างจากโปรแกรม InDesign ซึ่งสร้างขึ้น 
โดยใช้  Type Tool สำหรับพิมพ์ข้อความลงบนงานพิมพ์ และ  Type on a Path Tool สำหรับพิมพ์
ข้อความบนพาธ 

2. Text frame เป็นข้อความที่สร้างขึ้นภายในเฟรม ซึ่งข้อความประเภทนี้เราต้องสร้างเฟรมขึ้นมาก่อน 
โดยใช้ Frame Tool แล้วจึงใช้  Type Tool พิมพ์ข้อความลงในเฟรม 

 

2. รายละเอียดในการกำหนด Effect ในหน้าต่าง Type on a Path Options มีอะไรบ้างจงอธิบาย 

Rainbow เป็นการจัดวางตัวอักษรให้เอียง และตั้งฉากสัมพันธ์กับความโค้งของเส้นพาธ 

Skew เป็นการจัดวางตัวอักษรให้ตั้งตรง ไม่เอียงไปตามความโค้งของเส้นพาธ 

 

3D Ribbon เป็นการจัดวางตัวอักษรให้บิดเอียงดูมีมิติ  โดยด้านล่างของตัวอักษรยึดตรงกับเส้นพาธ 
และ 

  ดึงด้านบนของตัวอักษรให้เอียงตามเส้นพาธ 

Stair Step เป็นการจัดวางตัวอักษรให้ตั้งตรง และวางแต่ละตัวซ้อนกันเป็นขั้นๆ ไปตามเส้นพาธ  

  (ควรกำหนดระยะห่างของตัวอักษรให้เหมาะสม เพราะอาจทำให้ตัวอักษรซ้อนทับกันจนอ่าน 

  ไม่รู้เรื่อง) 

Gravity เป็นการจัดวางตัวอักษร โดยใช้จุดศูนย์กลางในการดึงตัวอักษรแต่ละตัวให้เอียงเป็นจุดเดียวกัน 

Ascender เป็นการจัดตำแหน่งข้อความให้อยู่ใต้เส้นพาธ 

Descender เป็นการจัดตำแหน่งข้อความ ให้อยู่เหนือเส้นพาธ 

Center เป็นการจัดตำแหน่งข้อความ ให้อยู่คร่อมเส้นพาธ 

Baseline เป็นการจัดตำแหน่งข้อความ ให้อยู่บนเส้นพาธพอดี 

Top กำหนดให้ข้อความอยู่ด้านบนจากตำแหน่งในช่อง Align 



Bottom กำหนดให้ข้อความอยู่ด้านล่างจากตำแหน่งในช่อง Align 

Center กำหนดให้ข้อความ อยู่ด้านตรงกลางจากตำแหน่งใน ช่อง Align.... 

 

3. ในหน้าต่าง Find/Change ช่อง Search การกำหนดขอบเขตการค้นหาสามารถแบ่งเป็น 5 แบบ มี
อะไรบ้าง 

All Document ค้นหาในทุกเนื้อหาในทุกไฟล์ที่เปิดอยู่ในขณะนั้น 

Document  ค้นหาในทุกเนื้อหาในไฟล์ที่ทำการค้นหาอยู่ 

Story  ค้นหาเฉพาะในเนื้อหาที่ทำการค้นหาอยู่ 

To End of Story ค้นหาเฉพาะเนื้อหาที่เหลือ นับจากตำแหน่งเคอร์เซอร์ ไปจนถึงเนื้อหาบรรทัด
สุดท้าย 

Selection  ค้นหาเฉพาะข้อความท่ีไฮไลท์ไว้ 
 

4. จงบอกขั้นตอนในการกำหนดรูปแบบการค้นหา และแทนที่โดยใช้หน้าต่าง Strory Editor พอเข้าใจ 

1. คลิกท่ีเมนู Edit->Find/Change หรือกดคีย์<Ctrl>+F เพ่ือค้นหาและแทนที่คำท่ีกำหนด 

2. ปรากฏหน้าต่าง Find/Change ขึ้นมา ให้พิมพ์คำที่ต้องการค้นหาลงในช่อง Find what 
และพิมพ์คำใหม่ที่ต้องการแทนที่ลงในช่อง Change to 

3. ในช่อง Search คลิกเลือกขอบเขตการแทนที่ 

4. คลิกเมาส์ที่ OK เพ่ือเริ่มการค้นหาและแทนที่คำ 

  

5. เราสามารถนำข้อความจากวัตถุที่สองมารวมกับวัตถุแรกได้ด้วยวิธีการอย่างไร 
1. คลิกเลือก Selection Tool แล้วคลิกเลือกวัตถุข้อความที่สองที่ต้องการรวมกับข้อความอ่ืน 

2. คลิกท่ีเมนู Edit->Cut หรือกดคีย์ <Ctrl>+X เพ่ือตัดข้อความ 

3.คลิกเลือก Type Tool เลือกตำแหน่งที่ต้องการจัดวางข้อความ 

4. คลิกท่ีเมนู Edit->Paste หรือกดคีย์ <Ctrl>+V 



5. ข้อความจากวัตถุที่สอง จะถูกรวมกับวัตถุแรก 

 

ตอนที่ 3 แบบฝึกปฏิบัติ 

จงพิมพ์ข้อความดังตัวอย่าง ใส่ลงในเฟรมรุูปสี่เหลี่ยม 2 รูป ลงใน 1 หน้ากระดาษ จากนั้นทำการบันทึก โดย
ตั้งชื่อว่า myfile2 

 

 

 

 

 

 

 

 

 

 

 

 



แผนจัดการเรียนรู้    วิชา   การใช้โปรแกรมคอมพิวเตอร์กราฟิก         รหัสวิชา   21909-2019    ชั้น   ปวช. 

หน่วยที่ 7    การปรับแต่งและจัดวางข้อความ   สัปดาห์ท่ี   9-10   เวลา   8   ชั่วโมง  

 

1.  สาระสำคัญ 

เรียนรู้การปรับแต่งข้อความท่ีเราได้สร้างขึ้น โดยการกำหนดรูปแบบ ได้แก ่ฟอนต์ ขนาด ลักษณะ ระยะห่าง
ตัวอักษร บรรทัด และรูปแบบของแท็บ/ย่อหน้า นอกจากการปรับแต่งค่าแล้ว ยังสามารถกำหนดรูปแบบข้อความ
เก็บไว้ใช้งานได้อีกด้วย 

  
2. ผลการเรียนรู้ที่คาดหวัง 

1. สามารถปรับแต่งอักษรจากพาเนล Charactor ได ้
2. อธิบายการปรับแต่งอักษรจาก Control Panel ได ้
3. บอกวิธีการจัดเรียงข้อความได้ 
4. อธิบายการขึ้นต้นย่อหน้าด้วตัวอักษรขนาดให่ได้ 
5. รู้จักเกี่ยวกับสไตล์ข้อความ 
6. สามารถเปลี่ยนสีข้อความได้ 
7.  อธิบายการนับคำในข้อความได้ 

 

 

 

 

 

 

 



3.  กิจกรรมการเรียนรู้ 

กิจกรรมครู กิจกรรมผู้เรียน 
ขั้นนำเข้าสู่บทเรียน(30 นาที) 

1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 
2. ให้นักศึกษาค้นคว้าคำเกี่ยวกับการปรับแต่งและ
จัดวางข้อความ 
3. ร่วมสนทนาเกี่ยวกับเรื่องการปรับแต่งและจัดวาง
ข้อความ 

 

1. ให้ความร่วมมือกับครูในการตรวจสอบ 

2. ค้นคว้า 

3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน(180 นาที) 
1. บอกจุดประสงค์การเรียน 
2. บรรยาย อธิบาย ยกตัวอย่าง แสดงวิธีการปฎิบัติ
ในแต่ละหัวข้อการเรืยนและให้นักศึกษาปฎิบัติไป
พร้อมกัน  
3. ให้คำแนะนำ  
4. ประเมินพฤติกรรมรายบุคคลโดยอาจารย์จะ
ซักถามในแต่ละบุคคล 

 
1. ฟัง ทำความเข้าใจและซักถาม 
2. ฟัง ทำความเข้าใจและปฎิบัติตาม 
3. ผู้เรียนซักถามข้อสงสัย 
4. รับการประเมิน 
 

ขั้นสรุป(30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. นักเรียนสอบถามข้อสงสัย 
3. ฟังและจดบันทึก 
4. ทำแบบทดสอบท้ายบท 

 

4.   กิจกรรมการเรียนรู้ 

 ก่อนเรียน 
1. ค้นคว้าคำเก่ียวกับการปรับแต่งและจัดวางข้อความ 
 ขณะเรียน 

1. ทำความเข้าใจและปฎิบัติตามในแต่ละหัวข้อการเรืยน 



2. ทำใบงานและแบบฝึกหัดหลังเรียน 

3. ร่วมกันเฉลยใบงานและแบบฝึกหัดหลังเรียน 

4. จดบันทึก เทคนิค แนวการที่เป็นประโยชน์ต่อผู้เรียน จากข้อแนะนำของครูผู้สอน 

5. ผู้เรียนสรุปความรู้ที่ได้จากการเรียนตามความเป็นจริง จากภูมิความรู้ของผู้เรียนแต่ละคน 

6. ผู้เรียนซักถามในหัวข้อที่สงสัยในเนื้อหาการเรียนรู้ 

 

5.  สื่อการเรียนการสอน 

1. หนังสือประกอบการเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก 

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจำหน่วย 

4. เครื่องไมโครคอมพิวเตอร์ 

5. แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 

6. ซีดีสื่อการสอนเรื่องระบบฐานข้อมูล 

 

6. วัดผลประเมินผล 

1. ผู้เรียนปฏิบัติภาระงานที่มอบหมายเสร็จทันเวลาที่กำหนด 

2. ตอบคำถามและสรุปผลงานได้อย่างถูกต้อง 

3. ทำแบบฝึกหัดหลังเรียนเสร็จทันเวลาที่กำหนดและถูกต้อง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบคำถาม สรุปสาระการเรียนรู้ และกล้าแสดงความคิดเห็น 

 

7.   กิจกรรมเสนอแนะ 

ถ้าผู้เรียนมีการเตรียมตัวในการเรียนที่ดี เช่น อ่าน และทำการศึกษาหนังสือเกี่ยวกับหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผู้เรียน จะสามารถเรียน และทำกิจกรรมต่าง ๆ ที่ครูผู้สอนมอบหมาย ได้อย่างมีความสุข และ
เกิดความชอบ และสนุกกับการเรียนในชั้นเรียน 
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ตอนที่ 1 จงตอบคำถามต่อไปนี้ 

1. จงบอกขั้นตอนในการเปลี่ยนสีของข้อความว่ามีอะไรบ้าง 

 1. คลิกเลือก  Type Tool จากนั้นเลือกข้อความท่ีต้องการเปลี่ยนสี 

 2. คลิกเลือกที่เมนู Window>Color หรือกดคีย ์<F6> เพ่ือเปิดพาเนล Color 

 3. จากนั้นคลิกที่   และเลือกโหมดสีที่เหมาะสมกับงานพิมพ์ ในตัวอย่างเลือกโหมดสี CMYK  

 4. ที่พาเนล Color จะปรากฏแถบเลื่อนของแม่สีจากโหมดสีเราเลือก โดยคลิกเลิือกโทนสีในช่อง  

     Spectum คลิกค้างที่ปุ่ม   และเลื่อนแถบ เพ่ือปรับผสมความเข้มข้นของแม่สี ให้ได้สีตามต้องการ  

    ซึ่งจะแสดงผลสีที่ช่อง Fill 

 5. อีกวิธีในการเลือกสี ให้ดับเบิ้ลคลิกท่ีช่อง Fill จะปรากฏหน้าต่าง Color Picker จากนั้นคลิกเลือกสีใน 

    กรอบ RGB Color Space View ให้คลิกค้างที่   และเลื่อนขึ้นเลื่อนลง เพ่ือปรับโทนสี โดยดู
ผลลัพธ์ 

        ของสีที่เลือกได้ที่ช่อง Color และ คลิกเมาส์ที่  เพ่ือยืนยันการเลือกสีที่ต้องการ 

 6. ข้อความที่เลือกไว้จะเปลี่ยนสีตามต้องการ 

 

 

2. การกำหนดลักษณะตัวอักษรมีข้ันตอนอะไรบ้าง จงอธิบาย 

 1. คลิกเลือก  Type Tool จากนั้นเลือกข้อความสำคัที่ต้องการเปลี่ยนลักษณะของตัวอักษร 

 2. คลิกเลือกลักษณะของตัวอักษรในช่อง Type Style ที่ต้องการ ซึ่งม ี4 ลักษณะ ดังนี้ 

  Regular ตัวปกต ิ (ข้อความ) 

  Italic ตัวเอียง (ข้อความ) 

  Bold ตัวหนา (ข้อความ) 

  Bold Italic ตัวหนาเอียง (ข้อความ) 

  ในตัวอย่างคลิกเลือก Bold Italic เพ่ือให้ข้อความเป็นตัวหนาเอียง 



 3. ข้อความที่เราคลิกเลือกนั้น จะเปลี่ยนลักษณะของตัวอักษรตามท่ีกำหนด 

 

3. จงบอกวิธีการในการนับจำนวนตัวอักษรในกรอบข้อความ 

1.1 คลิกเลือก  Type Tool  

1.2 คลิกเมาส์ที่กรอบข้อความ 

2.  คลิกที่เมนู Window->Info หรือกดคีย์ <F8> 

 

4. จงบอกรายละเอียดของพาเนล Charactor ว่ามีอะไรบ้าง 

 

 

 

4.1 คือ รูปแบบตัวอักษร (Font) 

4.2 คือ ขนาดตัวอักษร (Font Size) 
        4.3 คือ ปรับช่องไฟตัวอักษร (Kerning) 

4.4 คือ ปรับความสูงของตัวอักษร (Vertical Scale) 
4.5 คือ ปรับการยกตัวอักษร (Baseline Shift) 
4.6 คือ ภาษา (Language) 
4.7 คือ ลักษณะตัวอักษร (Type Style) 
4.8 คือ ระยะห่างของบรรทัด (Leading) 
4.9 คือ ปรับเพิ่ม/ลดระยะห่าง (Tracking) 
4.10  คือ ปรับความกว้างของตัวอักษร (Horizontal Scale) 



4.11 คือ ปรับองศาการเอียงตัวอักษร (Skew) 
 

5. จงบอกรายละเอียดของปุ่มที่ใช้ในการจัดเรียงข้อความในพาเนล Paragraph ว่ามีอะไรบ้าง 
 

 

  คือ จัดเรียงข้อความชิดซ้าย 

  คือ จัดเรียงข้อความตรงกลาง 

 คือ  จัดเรียงข้อความชิดขวา 

 คือ จัดเรียงข้อความเหยียดเต็มบรรทัดสุดท้ายชิดซ้าย 

 คือ จัดเรียงข้อความเหยียดเต็มบรรทัดสุดท้ายจัดกลาง 

 คือ จัดเรียงข้อความเหยียดเต็มบรรทัดสุดท้ายชิดขวา 

 คือ จัดเรียงข้อความเหยียดเต็มทุกบรรทัด 

 คือ จัดเรียงข้อความชิดด้านฝั่งหยักน้อย 
 คือ จัดเรียงข้อความชิดด้านฝั่งหยักมาก 

 

ตอนที่ 2 แบบฝีกปฏิบัติ 

เปิดไฟล์จากแบบฝึกปฏิบัติที่ผ่านมา (myfile2) แล้วกำหนดชื่อเรื่องเพียง 1 เรื่อง (วางชื่อเรื่องไว้ที่บรรทัด
บนสุดของข้อความ) โดยใช้ขนาดตัวอักษร 36 pt โดยจะใช้รูปแบบและลักษณะใดก็ได้ ใส่สีตกแต่งตามต้องการ 
จากนั้นกำหนดให้ตัวอักษรตัวแรกของย่อหน้าเป็นตัวอักษรตัวให่ แล้วบันทึกเป็น myfile3 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



แผนจัดการเรียนรู้    วิชา   การใช้โปรแกรมคอมพิวเตอร์กราฟิก          รหัสวิชา   21909-2019    ชั้น   ปวช. 

หน่วยที่ 8    การวาดวัตถุประกอบ    สัปดาห์ท่ี   11-12   เวลา   6   ชั่วโมง  

 

1.  สาระสำคัญ 

 การจัดหน้าหนังสือ หรือการออกแบบชิ้นงานส่วนประกอบที่สำคัอีกอย่างหนึ่งนอกจากตัวอักษรก็คือภาพ
วัตถุท่ีจะนำมาใช้ประกอบ ซึ่งโปรแกรม InDesign ก็มีเครื่องมือสำหรับวาดภาพให้ใช้งานได้อย่างสะดวกสบาย 
ซึ่งในบทนี้จะกล่าวถึงการวาดภาพวัตถุด้วยเครื่องมือสร้างภาพต่างๆ โดยจะอธิบายถึงหลักการของภาพวาดว่า 
ภาพที่วาดออกมาจะมีลักษณะอย่างไร และมีการใช้งานเครื่องมืออย่างไร 

 

  
2. ผลการเรียนรู้ที่คาดหวัง 

1. รู้จักเกี่ยวกับเส้นพาธ 
2. สามารถการวาดเส้นตรงได้ 
3. สามารถวาดรูปทรงแบบตายตัวได้ 
4.  สามารถวาดรูปทรงอย่างอิสระได้ 

 

 

 

 

 

 

 

 



3.  กิจกรรมการเรียนรู้ 

กิจกรรมครู กิจกรรมผู้เรียน 
ขั้นนำเข้าสู่บทเรียน(30 นาที) 

1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 
2. ให้นักศึกษาค้นคว้าคำเกี่ยวกับการวาดวัตถุ
ประกอบ 
3. ร่วมสนทนาเกี่ยวกับเรื่อง การวาดวัตถุประกอบ 
 

 

1. ให้ความร่วมมือกับครูในการตรวจสอบ 

2. ค้นคว้า 

3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน(180 นาที) 
1. บอกจุดประสงค์การเรียน 
2. บรรยาย อธิบาย ยกตัวอย่าง แสดงวิธีการปฎิบัติ
ในแต่ละหัวข้อการเรืยนและให้นักศึกษาปฎิบัติไป
พร้อมกัน  
3. ให้คำแนะนำ  
4. ประเมินพฤติกรรมรายบุคคลโดยอาจารย์จะ
ซักถามในแต่ละบุคคล 

 
1. ฟัง ทำความเข้าใจและซักถาม 
2. ฟัง ทำความเข้าใจและปฎิบัติตาม 
3. ผู้เรียนซักถามข้อสงสัย 
4. รับการประเมิน 
 

ขั้นสรุป(30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. นักเรียนสอบถามข้อสงสัย 
3. ฟังและจดบันทึก 
4. ทำแบบทดสอบท้ายบท 

 

4.   กิจกรรมการเรียนรู้ 

 ก่อนเรียน 
 1. ค้นคว้าคำเก่ียวกับการวาดวัตถุประกอบ 

 ขณะเรียน 

1. ทำความเข้าใจและปฎิบัติตามในแต่ละหัวข้อการเรืยน 



2. ทำใบงานและแบบฝึกหัดหลังเรียน 

3. ร่วมกันเฉลยใบงานและแบบฝึกหัดหลังเรียน 

4. จดบันทึก เทคนิค แนวการที่เป็นประโยชน์ต่อผู้เรียน จากข้อแนะนำของครูผู้สอน 

5. ผู้เรียนสรุปความรู้ที่ได้จากการเรียนตามความเป็นจริง จากภูมิความรู้ของผู้เรียนแต่ละคน 

6. ผู้เรียนซักถามในหัวข้อที่สงสัยในเนื้อหาการเรียนรู้ 

 

5.  สื่อการเรียนการสอน 

1. หนังสือประกอบการเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก 

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจำหน่วย 

 4. เครื่องไมโครคอมพิวเตอร์ 

5. แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 

6. ซีดีสื่อการสอนเรื่องระบบฐานข้อมูล 

 

6. วัดผลประเมินผล 

1. ผู้เรียนปฏิบัติภาระงานที่มอบหมายเสร็จทันเวลาที่กำหนด 

2. ตอบคำถามและสรุปผลงานได้อย่างถูกต้อง 

3. ทำแบบฝึกหัดหลังเรียนเสร็จทันเวลาที่กำหนดและถูกต้อง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบคำถาม สรุปสาระการเรียนรู้ และกล้าแสดงความคิดเห็น 

 

7.   กิจกรรมเสนอแนะ 

ถ้าผู้เรียนมีการเตรียมตัวในการเรียนที่ดี เช่น อ่าน และทำการศึกษาหนังสือเกี่ยวกับหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผู้เรียน จะสามารถเรียน และทำกิจกรรมต่าง ๆ ที่ครูผู้สอนมอบหมาย ได้อย่างมีความสุข และ
เกิดความชอบ และสนุกกับการเรียนในชั้นเรียน 
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ตอนที ่1 จงทำเครื่องหมาย  ล้อมรอบตัวเลือกท่ีถูกต้องที่สุด 

จงใช้คำตอบต่อไปนี้ ตอบคำถามข้อ 1 - 4 

ก. จุดยึดส่วนโค้ง 

ข. เส้นพาธแบบปิด 

ค. เส้นพาธแบบเปิด 

ง. จุดยึดส่วนมุม 

1. เส้นที่มีจุดยึด จุดเริ่มต้น และจุดจบของพาธ ไม่เป็นจุดเดียวกัน หมายถึงข้อใด ตอบ ค. 

2. จุดที่เชื่อมต่อเส้นตรงเข้ากับเส้นตรง ซึ่งจะอยู่ในลักษณะของมุม หมายถึงข้อใด ตอบ ง. 

3. จุดยึดที่เชื่อมต่อระหว่างเส้นโค้งกับเส้นโค้ง ซึ่งจะมีลักษณะเป็นส่วนโค้งท่ีมีความต่อเนื่องกัน  

   หมายถึงข้อใด ตอบ ก. 

4. เส้นที่มีจุดยึด จุดเริ่มต้นของพาธ และจุดจบของพาธเป็นจุดเดียวกัน หมายถึงข้อใด ตอบ ข. 

5. ข้อใดต่อไปนี้ไม่เกี่ยวข้องกับการวาดรูปทรงแบบตายตัว 

ก. Rectangle Tool  

ข. Ellipse Tool  

ค. Polygon Tool  

ง. Pen Tool  

 

 

6. เครื่องมือ  Delete Anchor Point Tool หมายถึงข้อใด  

ก. ใช้เปลี่ยนแขนของเส้นพาธให้เป็นเส้นโค้งหรือเส้นตรง 

ข. ใช้เพิ่มจุดในแนวเส้นพาธ 



ค. ใช้ลบจุดในแนวเส้นพาธ 
ง. ใช้วาดเส้นด้วยปากกา 

 

7. เครื่องมือ  Convert Direction Point Tool หมายถึงข้อใด  

ก. ใช้เปลี่ยนแขนของเส้นพาธให้เป็นเส้นโค้งหรือเส้นตรง 

ข. ใช้เพิ่มจุดในแนวเส้นพาธ 

ค. ใช้ลบจุดในแนวเส้นพาธ 

ง. ใช้วาดเส้นด้วยปากกา 

 

8. เครื่องมือ  Add Anchor Point Tool หมายถึงข้อใด  

ก. ใช้วาดเส้นด้วยปากกา 

ข. ใช้เพิ่มจุดในแนวเส้นพาธ 

ค. ใช้ลบจุดในแนวเส้นพาธ 

ง. ใช้เปลี่ยนแขนของเส้นพาธให้เป็นเส้นโค้งหรือเส้นตรง 

 

9. เครื่องมือใดในข้อต่อไปนี้ ใช้เพ่ือการลบเส้นที่ไม่ต้องการ 

ก. Smooth Tool  

ข. Erase Tool  

ค. Rectangle Tool  

ง. Pen Tool  

10. เครื่องมือใดในข้อต่อไปนี้ ใช้เพื่อการตกแต่งเส้นโค้งให้เรียบ 

ก. Smooth Tool  

ข. Erase Tool  

ค. Rectangle Tool  



ง. Pen Tool  

 

ตอนที่ 3 แบบฝึกปฏิบัติ 

จงวาดภาพดอกไม้อยู่ในแจกัน โดยใช้เส้นสีดำในการวาด และไม่ต้องลงสี จากนั้นทำการบันทึกลงในชื่อ 
myfile4 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
แผนจัดการเรียนรู้    วิชา   การใช้โปรแกรมคอมพิวเตอร์กราฟิก          รหัสวิชา   21909-2019    ชั้น   ปวช. 

หน่วยที่ 9    การใช้งานวัตถุ     สัปดาห์ท่ี   13-14   เวลา   8   ชั่วโมง  

 

1.  สาระสำคัญ 

การใช้งานวัตถ ุได้แก่ การเลือกวัตถุ การเคลื่อนย้าย การปรับขนาด การคัดลอก การหมุน การกลับภาพ การ
บิด การคร็อป และการล็อค เป็นต้น การใช้งานวัตถุพ้ืนฐานเป็นเรื่องที่จำเป็นอย่างมาก ในการจัดวางชิ้นงานบน
หน้ากระดาษ เพราะองค์ประกอบที่แสดงอยู่บนหน้ากระดาษนั้นเป็นวัตถุท้ังหมด 

 
2. ผลการเรียนรู้ที่คาดหวัง 

1. อธิบายการเลือกและเคลื่อนย้ายวัตถุได้ 
2. สามารถปรับขนาดวัตถุได้ 
3. สามรถคัดลอก และวางวัตถุโดยใช้ Paste in Place ได ้
4. บอกวิธีการหมุนวัตถุโดยใช้ Rotating Tool ได้ 
5. สามารถบิด และการพลิกกลับด้านวัตถุได้ 
6. อธิบายการล็อควัตถุได้ 
7. อธิบายการคร็อปรูปภาพได้ 
8. สามารถลบวัตถุได้ 
9. อธิบายการมาสก์วัตถุได้ 
10.อธิบายการรวมกลุ่ม และจัดลำดับการซ้อนวัตถุได้ 
11.สามารถจัดเรียงวัตถุได้ 

 

 

 

 



3.  กิจกรรมการเรียนรู้ 

กิจกรรมครู กิจกรรมผู้เรียน 
ขั้นนำเข้าสู่บทเรียน(30 นาที) 

1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 
2. ให้นักศึกษาค้นคว้าคำเก่ียวกับการใช้งานวัตถ ุ
3. ร่วมสนทนาเกี่ยวกับเรื่องการใช้งานวัตถ ุ

 

1. ให้ความร่วมมือกับครูในการตรวจสอบ 

2. ค้นคว้า 

3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน(180 นาที) 
1. บอกจุดประสงค์การเรียน 
2. บรรยาย อธิบาย ยกตัวอย่าง แสดงวิธีการปฎิบัติ
ในแต่ละหัวข้อการเรืยนและให้นักศึกษาปฎิบัติไป
พร้อมกัน  
3. ให้คำแนะนำ  
4. ประเมินพฤติกรรมรายบุคคลโดยอาจารย์จะ
ซักถามในแต่ละบุคคล 

 
1. ฟัง ทำความเข้าใจและซักถาม 
2. ฟัง ทำความเข้าใจและปฎิบัติตาม 
3. ผู้เรียนซักถามข้อสงสัย 
4. รับการประเมิน 
 

ขั้นสรุป(30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. นักเรียนสอบถามข้อสงสัย 
3. ฟังและจดบันทึก 
4. ทำแบบทดสอบท้ายบท 

 

4.   กิจกรรมการเรียนรู้ 

 ก่อนเรียน 
1. ค้นคว้าคำเก่ียวกับการใช้งานวัตถุ 
 ขณะเรียน 

1. ทำความเข้าใจและปฎิบัติตามในแต่ละหัวข้อการเรืยน 



2. ทำใบงานและแบบฝึกหัดหลังเรียน 

3. ร่วมกันเฉลยใบงานและแบบฝึกหัดหลังเรียน 

4. จดบันทึก เทคนิค แนวการที่เป็นประโยชน์ต่อผู้เรียน จากข้อแนะนำของครูผู้สอน 

5. ผู้เรียนสรุปความรู้ที่ได้จากการเรียนตามความเป็นจริง จากภูมิความรู้ของผู้เรียนแต่ละคน 

6. ผู้เรียนซักถามในหัวข้อที่สงสัยในเนื้อหาการเรียนรู้ 

 

5.  สื่อการเรียนการสอน 

1. หนังสือประกอบการเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก 

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจำหน่วย 

4. เครื่องไมโครคอมพิวเตอร์ 

5. แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 

6. ซีดีสื่อการสอนเรื่องระบบฐานข้อมูล 

 

6. วัดผลประเมินผล 

1. ผู้เรียนปฏิบัติภาระงานที่มอบหมายเสร็จทันเวลาที่กำหนด 

2. ตอบคำถามและสรุปผลงานได้อย่างถูกต้อง 

3. ทำแบบฝึกหัดหลังเรียนเสร็จทันเวลาที่กำหนดและถูกต้อง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบคำถาม สรุปสาระการเรียนรู้ และกล้าแสดงความคิดเห็น 

 

7.   กิจกรรมเสนอแนะ 

ถ้าผู้เรียนมีการเตรียมตัวในการเรียนที่ดี เช่น อ่าน และทำการศึกษาหนังสือเกี่ยวกับหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผู้เรียน จะสามารถเรียน และทำกิจกรรมต่าง ๆ ที่ครูผู้สอนมอบหมาย ได้อย่างมีความสุข และ
เกิดความชอบ และสนุกกับการเรียนในชั้นเรียน 
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ตอนที่ 1 จงตอบคำถามต่อไปนี้ 

1. การคัดลอกวัตถุมี 3 วิธี จงอธิบายขั้นตอนของแต่ละวิธีมาอย่างละเอียด 

วิธีที่ 1 1. ใช้  Selection Tool คลิกเลือกวัตถุที่ต้องการคัดลอก 
  2. เลือกคำสั่ง Edit>Copy หรือกดปุ่ม <Ctrl>+C ที่คีย์บอร์ด เพ่ือคัดลอกวัตถุ 
  3. เลือกคำสั่ง Edit>Paste หรือกดปุ่ม <Ctrl>+V ที่คีย์บอร์ด เพ่ือวางวัตถุที่คัดลอกมา 

  4.จะปรากฏวัตถุใหม่ที่ได้จากการคัดลอก 

วิธีที่ 2 1. คลิกเมาส์เลือกวัตถุ 

  2. คลิกเมาส์ขวาเลือก Copy เพ่ือคัดลอกวัตถุ 

  3. คลิกเมาส์ขวาเลือก Paste เพ่ือวางวัตถุ 

วิธีที่ 3 1. คลิกเมาส์เลือกวัตถุพร้อมกับกดปุ่ม <Alt> ค้างไว้ 

  2. ลากเมาส์เลื่อนวัตถุไปวางยังตำแหน่งใหม่ 

  3. ปล่อยเมาส์ วัตถุจะถูกตัดลอกเพ่ิมข้ึน 

 

2. รูปแบบในการซ้อนวัตถุมีอะไรบ้าง 

 Bring to Front  เลื่อนวัตถุข้ึนมาให้อยู่บนสุด 

 Bring Forward  เลื่อนวัตถุข้ึนมา 1 ชั้น 

 Send Backward  เลื่อนวัตถุลงไป 1 ชั้น 

 Send to Back  เลื่อนวัตถุไปอยู่หลังสุดของวัตถุท้ังหมด 

 

3. จงอธิบายวิธีการหมุนโดยใช้ Rotate Tool 
 1. ใช้  Selection Tool คลิกเลือกวัตถุที่ต้องการหมุน 
 2. คลิกเลือก  Rotate Tool จากกล่องเครื่องมือ เพ่ือหมุนวัตถุ 



 3. คลิกเมาส์วางจุดหมุน   บริเวณท่ีต้องการ เพ่ือกำหนดให้เป็นจุดหมุนของวัตถุ 
 4. ลากเมาส์เพื่อหมุนวัตถุให้อยู่ในตำแหน่งที่เราต้องการ 

 5. ปล่อยเมาส์ วัตถุจะถูกหมุนตามท่ีเราต้องการทันที 

 

4. ในการกำหนดรูปแบบการจัดเรียงตามแนว ในพาเนล Align มีอะไรบ้างจงอธิบาย 

 

 

 

5. จงอธิบายวิธีการในการมาสก์วัตถุว่าทำอย่างไรบ้าง 
 1. เตรียมภาพที่ต้องการมาสก์ ในตัวอย่างเป็นรูปผีเสื้อ 



 2. วาดวัตถุท่ีต้องการใช้เป็นตัวมาสก์ไว้บนรูปภาพ จากตัวอย่างวาดรูปวงกลมจากเครื่องมือ Ellipse  
     Frame Tool 
 3. คลิกเลือกวัตถุรูปภาพมดแล้วคลิกท่ี Edit>Copy 
 4. คลิกเลือกวัตถุวงกลมแล้วเลือกคำสั่ง Edit>Paste Into เพ่ือมาสก์รูปภาพ  
 5. รูปภาพจะถูกมาสก์ให้แสดงในรูปทรงตามที่ต้องการทันที โดยรูปภาพที่ทำการมาสก์จะยังซ้อนอยู่บน 
    รูปภาพต้นแบบ 
 6. คลิกแล้วลากวัตถุวงกลมออกมายังพ้ืนที่ภายนอก 
 7. จะเห็นว่ารูปมดถูกมาสก์ด้วยรูปวงกลม 

ตอนที่ 2 แบบฝึกห้ดภาคปฏิบัติ 

เปิดไฟล์จากแบบฝึกหัดที่ผ่านมา จากนั้นทำการคัดลอกภาพเป็น 4 ภาพพร้อมทั้งตั้งชื่อภาพวางที่ด้านล่างของ
หน้ากระดาษ แล้วบันทึกเป็น myfile5 
 

 

 

 

 

 

 

 

 

 

 



แผนจัดการเรียนรู้    วิชา   การใช้โปรแกรมคอมพิวเตอร์กราฟิก        รหัสวิชา   21909-2019    ชั้น   ปวช. 

หน่วยที่  10    ความรู้เรื่องสีและการใช้งานสี   สัปดาห์ท่ี   15-16   เวลา   8   ชั่วโมง  

 

1.  สาระสำคัญ 

 สีบนจอภาพ หรือสิ่งพิมพ์ที่เราเห็นนั้นเกิดจากการผสมสีที่ลอกเลียนแบบธรรมชาติ ซึ่งโปรแกรมกราฟิก
อย่าง InDesign ได้นำหลักการแสดงสีของโมเดลสีเข้ามาประยุกต์ให้เกิดเป็นโหมดสำหรับใช้งานได้หลากหลาย 
ความรู้เรื่องสีจึงมีความสำคัอย่างยิ่งสำหรับคนที่ต้องการออกแบบภาพกราฟิก ซึ่งในบทนี้นำความรู้ต่างๆ 
เกี่ยวกับสี และการระบายสีภาพด้วยวิธีต่างๆ มากล่าวถึงอย่างละเอียด เพ่ือให้ได้ภาพที่ออกมาสวยงามได้ตามที่
เราต้องการ 

  
2. ผลการเรียนรู้ที่คาดหวัง 

1. รู้จักโมเดลการมองเห็นสีทั่วไป 
2. บอกโหมดสีที่ใช้งานโปรแกรม InDesign ได้ 
3. อธิบายการใส่สีให้วัตถุได้ 
4. อธิบายการเลือกสีจาก Color Picker, พาเนล Color และพาเนล Swatches ได้ 
5. สามารถทำการระบายสีด้วยเครื่องมือ Eyedropper Tool ได ้
6. สามารถการระบายสีแบบไล่โทนได้ 

 

 

 

 

 

 

 



3.  กิจกรรมการเรียนรู้ 

กิจกรรมครู กิจกรรมผู้เรียน 
ขั้นนำเข้าสู่บทเรียน(30 นาที) 

1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 
2. ให้นักศึกษาค้นคว้าคำเกี่ยวกับความรู้เรื่องสีและ
การใช้งานสี 
3. ร่วมสนทนาเกี่ยวกับเรื่องความรู้เรื่องสีและการใช้
งานสี 

 

1. ให้ความร่วมมือกับครูในการตรวจสอบ 

2. ค้นคว้า 

3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน(180 นาที) 
1. บอกจุดประสงค์การเรียน 
2. บรรยาย อธิบาย ยกตัวอย่าง แสดงวิธีการปฎิบัติ
ในแต่ละหัวข้อการเรืยนและให้นักศึกษาปฎิบัติไป
พร้อมกัน  
3. ให้คำแนะนำ  
4. ประเมินพฤติกรรมรายบุคคลโดยอาจารย์จะ
ซักถามในแต่ละบุคคล 

 
1. ฟัง ทำความเข้าใจและซักถาม 
2. ฟัง ทำความเข้าใจและปฎิบัติตาม 
3. ผู้เรียนซักถามข้อสงสัย 
4. รับการประเมิน 
 

ขั้นสรุป(30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. นักเรียนสอบถามข้อสงสัย 
3. ฟังและจดบันทึก 
4. ทำแบบทดสอบท้ายบท 

 

4.   กิจกรรมการเรียนรู้ 

 ก่อนเรียน 
2. ค้นคว้าคำเก่ียวกับความรู้เรื่องสีและการใช้งานสี 
 ขณะเรียน 

1. ทำความเข้าใจและปฎิบัติตามในแต่ละหัวข้อการเรืยน 



2. ทำใบงานและแบบฝึกหัดหลังเรียน 

3. ร่วมกันเฉลยใบงานและแบบฝึกหัดหลังเรียน 

4. จดบันทึก เทคนิค แนวการที่เป็นประโยชน์ต่อผู้เรียน จากข้อแนะนำของครูผู้สอน 

5. ผู้เรียนสรุปความรู้ที่ได้จากการเรียนตามความเป็นจริง จากภูมิความรู้ของผู้เรียนแต่ละคน 

6. ผู้เรียนซักถามในหัวข้อที่สงสัยในเนื้อหาการเรียนรู้ 

 

5.  สื่อการเรียนการสอน 

1. หนังสือประกอบการเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก 

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจำหน่วย 

4. เครื่องไมโครคอมพิวเตอร์ 

5. แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 

6. ซีดีสื่อการสอนเรื่องระบบฐานข้อมูล 

 

6. วัดผลประเมินผล 

1. ผู้เรียนปฏิบัติภาระงานที่มอบหมายเสร็จทันเวลาที่กำหนด 

2. ตอบคำถามและสรุปผลงานได้อย่างถูกต้อง 

3. ทำแบบฝึกหัดหลังเรียนเสร็จทันเวลาที่กำหนดและถูกต้อง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบคำถาม สรุปสาระการเรียนรู้ และกล้าแสดงความคิดเห็น 

 

7.   กิจกรรมเสนอแนะ 

ถ้าผู้เรียนมีการเตรียมตัวในการเรียนที่ดี เช่น อ่าน และทำการศึกษาหนังสือเกี่ยวกับหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผู้เรียน จะสามารถเรียน และทำกิจกรรมต่าง ๆ ที่ครูผู้สอนมอบหมาย ได้อย่างมีความสุข และ
เกิดความชอบ และสนุกกับการเรียนในชั้นเรียน 
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ตอนที่ 1 จงตอบคำถามต่อไปนี้ 

1. จงอธิบายขั้นตอนในการเลือกสีจากพาเนล Swatches 

ในการเลือกสีจากพาเนล Swatches ให้ใช้คำสั่ง Window->Color ให้มีเครื่องหมายถูก หน้าคำสั่งนี้ ซึ่งจะ
ปรากฏพาเนล Color ขึ้นมา จากนั้นทำตามข้ันตอนดังนี้ 

1. คลิกเลือกวัตถุ 

2. คลิกเลือกกำหนดสีพื้น หรือสีเส้น 

3. คลิกเลือกสีที่ต้องการ 

 

2. จงบอกขั้นตอนในการระบายสีด้วย Eyedropper Tool 

1. คลิกเลือกวัตถุ 

2. คลิกเลือก Eyedropper Tool 

3. เลือกสีจากต้นแบบ 

 

3. จงอธิบายขั้นตอนในการเลือกสีจาก Color Picker  

1. คลิกเลือกวัตถุ 

2. ดับเบ้ิลคลิกเมาส์ท่ีสีพ้ืนหรอืสีเสน้ 

3. เลื่อนสไลด์เลือกโทนสี 

4. กำหนดค่าสีโดยการคลิกเมาส์ 

5. คลิกเมาส์ที่ OK เพ่ือตกลงใช้สีที่เลือก 

 

4. จงบอกส่วนประกอบที่อยู่ในพาเนล Gradient 



 

 

 4.1 คือ กำหนดลักษณะการไล่สี   4.2 คือ ตัวอย่างการไล่สี 

 4.3 คือ แสดงตำแหน่งจุดสีที่เราทำการปรับอยู่ 4.4 คือ สลับทิศทางการไล่เฉดสี 
 4.5 คือ จุดสีแต่ละจุด    4.6 คือ กำหนดค่ามุมเอียงของการไล่สีแบบ Linear 
 4.7 คือ จุดระหว่างสีสองสี เพ่ือกำหนดขอบเขตการไล่โทนของสี 

 

5. จงบอกความหมายของเครื่องมือเหล่านี้ 

 

 

 5.1 คือ สีพื้น (Fill)    5.2 คือ สีพื้นฐานของโปรแกรม 
 5.3 คือ กำหนดรูปแบบการใส่สี   5.4 คือ สลับสีพ้ืน และสีเส้น 
 5.5 คือ สีเส้น (Stroke)    5.6 คือ กำหนดให้ใส่สีวัตถุ หรือตัวอักษร 
 

ตอนที่ 2 แบบฝึกปฏิบัติ 

เปิดไฟล์จากแบบฝึกที่ผ่านมา (myfile5) จากนั้นทำการใส่สีที่ภาพ โดยกำหนดให้ในภาพมีที่การลงสีแบบ
ธรรมดาและการลงสีแบบ gradient แล้วบันทึกเป็น myfile6 



แผนจัดการเรียนรู้    วิชา   การใช้โปรแกรมคอมพิวเตอร์กราฟิก        รหัสวิชา   21909-2019    ชั้น   ปวช. 

หน่วยที่ 11    เทคนิคการปรับแต่งภาพ    สัปดาห์ท่ี   17-18   เวลา   8   ชั่วโมง  

 

1.  สาระสำคัญ 

 ภาพที่เรานำเข้ามาใช้งานในโปรแกรม InDesign นั้น ในบทนี้เราจะมาทำการปรับแต่งทั้งภาพด้วยเอฟ
เฟ็กต์ในโปรแกรม การใช้งานภาพร่วมกับข้อความรวมถึงการสร้างและการใช้งานเฟรม ซึ่งจะทำให้ภาพมีความ
น่าสนใจยิ่งขึ้น 

 

  
2. ผลการเรียนรู้ที่คาดหวัง 

1. รู้และเข้าใจในการตั้งค่าการแสดงผล 
2. อธิบายการปรับแต่งภาพได้ 
3. สามารถจัดวางข้อความล้อมรอบรูปภาพได้ 
4. อธิบายการใช้งานเฟรมกับภาพได้ 
5. สามารถใส่ภาพรวมกับข้อความได้ 

 

 

 

 

 

 

 

 



3.  กิจกรรมการเรียนรู้ 

กิจกรรมครู กิจกรรมผู้เรียน 
ขั้นนำเข้าสู่บทเรียน(30 นาที) 

1. ตรวจสอบรายชื่อนักศึกษาที่เข้าเรียน 
2. ให้นั กศึกษาค้นคว้าคำเกี่ ยวกับ เทคนิคการ
ปรับแต่งภาพ 
3. ร่วมสนทนาเกี่ยวกับเรื่องเทคนิคการปรับแต่งภาพ 

 

1. ให้ความร่วมมือกับครูในการตรวจสอบ 

2. ค้นคว้า 

3. ร่วมสนทนาและแสดงความคิดเห็น 

ขั้นดำเนินการสอน(180 นาที) 
1. บอกจุดประสงค์การเรียน 
2. บรรยาย อธิบาย ยกตัวอย่าง แสดงวิธีการปฎิบัติ
ในแต่ละหัวข้อการเรืยนและให้นักศึกษาปฎิบัติไป
พร้อมกัน  
3. ให้คำแนะนำ  
4. ประเมินพฤติกรรมรายบุคคลโดยอาจารย์จะ
ซักถามในแต่ละบุคคล 

 
1. ฟัง ทำความเข้าใจและซักถาม 
2. ฟัง ทำความเข้าใจและปฎิบัติตาม 
3. ผู้เรียนซักถามข้อสงสัย 
4. รับการประเมิน 
 

ขั้นสรุป(30 นาที) 
1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. เปิดโอกาสให้นักเรียนซักถามข้อสงสัย 
3. มอบหมายให้ไปหัดทำและศึกษาเพ่ิมเติม 
4. ทำแบบทดสอบ 

 

1. ครูและนักเรียนร่วมกันสรุปสาระสำคัญ 
2. นักเรียนสอบถามข้อสงสัย 
3. ฟังและจดบันทึก 
4. ทำแบบทดสอบท้ายบท 

 

4.   กิจกรรมการเรียนรู้ 

 ก่อนเรียน 
3. ค้นคว้าคำเก่ียวกับเทคนิคการปรับแต่งภาพ 
 ขณะเรียน 

1. ทำความเข้าใจและปฎิบัติตามในแต่ละหัวข้อการเรืยน 



2. ทำใบงานและแบบฝึกหัดหลังเรียน 

3. ร่วมกันเฉลยใบงานและแบบฝึกหัดหลังเรียน 

4. จดบันทึก เทคนิค แนวการที่เป็นประโยชน์ต่อผู้เรียน จากข้อแนะนำของครูผู้สอน 

5. ผู้เรียนสรุปความรู้ที่ได้จากการเรียนตามความเป็นจริง จากภูมิความรู้ของผู้เรียนแต่ละคน 

6. ผู้เรียนซักถามในหัวข้อที่สงสัยในเนื้อหาการเรียนรู้ 

 

 

5.  สื่อการเรียนการสอน 

1. หนังสือประกอบการเรียนวิชา การใช้โปรแกรมคอมพิวเตอร์กราฟิก 

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจำหน่วย 

     4. เครื่องไมโครคอมพิวเตอร์ 

5. แผ่นใสและเครื่องฉายภาพข้ามศีรษะ 

6. ซีดีสื่อการสอนเรื่องระบบฐานข้อมูล 

 

6. วัดผลประเมินผล 

1. ผู้เรียนปฏิบัติภาระงานที่มอบหมายเสร็จทันเวลาที่กำหนด 

2. ตอบคำถามและสรุปผลงานได้อย่างถูกต้อง 

3. ทำแบบฝึกหัดหลังเรียนเสร็จทันเวลาที่กำหนดและถูกต้อง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบคำถาม สรุปสาระการเรียนรู้ และกล้าแสดงความคิดเห็น 

 

7.   กิจกรรมเสนอแนะ 



ถ้าผู้เรียนมีการเตรียมตัวในการเรียนที่ดี เช่น อ่าน และทำการศึกษาหนังสือเกี่ยวกับหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผู้เรียน จะสามารถเรียน และทำกิจกรรมต่าง ๆ ที่ครูผู้สอนมอบหมาย ได้อย่างมีความสุข และ
เกิดความชอบ และสนุกกับการเรียนในชั้นเรียน 
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ตอนที่ 1 จงตอบคำถามต่อไปนี้ 

 

1. การแยกรูปภาพออกเป็นวัตถุอิสระ มีวิธีการอย่างไร 

1. คลิกท่ี Direction Selection Tool แล้วคลิกท่ีวัตถุ 

2. เลือกคำสั่ง Edit->Cut 

3. เลือกคำสั่ง Edit->Paste  เพ่ือวางภาพนอกพ้ืนที่เฟรม 

4. วัตถุเฟรมและรูปภาพถูกแยกออกจากกัน 

 

2. การใส่รูปภาพลงในเฟรมมีวิธีการอย่างไร  

ก่อนที่จะใส่รูปภาพลงในเฟรม ต้องทำการสร้างเฟรมจากเครื่องมือ Frame Tool จากกล่องเครื่องมือ ซ่ึง
สามารถสร้างได้ทั้งรูปสี่เหลี่ยม  รูปวงกลม  และรูปหลายเหลี่ยม  ดังนี้ 
1. 1 คลิกปุ่มเครื่องมือค้างไว้จะแสดงรูปแบบเฟรมทั้งหมด 
1.2 เลือกเครื่องมือการสร้างเฟรมที่ต้องการ 
2. ลากเมาส์เพื่อวาดเฟรม 
3. ปล่อยเมาส์ จะได้เฟรมที่วาดไว้ 

การใส่รูปภาพลงในเฟรม 

1. คลิกเลือกรูปภาพที่ต้องการบรรจุลงในเฟรม 

2. เลือกคำสั่ง Edit->Cut 

3. คลิกเลือกเฟรมทีต้องการใส่รูปภาพ 

4. เลือกคำสั่ง Edit->Paste  into 



 

3. การลบรูปภาพที่อยู่ในเฟรมมีวิธีการอย่างไร 

1. คลิกท่ี Direction Selection Tool แล้วคลิกเลือกเฟรมที่บรรจุรูปภาพ 

2. เลือกคำสั่ง Edit->Clear เพ่ือลบรูปภาพออกจากเฟรม 

3. รูปภาพที่อยู่ในเฟรมจะถูกลบทิ้งไป 

 

4. ลักษณะของการปรับแต่งเอฟเฟ็กต์ให้กับวัตถุต่างๆ มีอะไรบ้าง 

 Drop Shadow  สร้างเงาให้กับ Object, Stroke, Fill, และ Text ด้านนอกของกรอบเฟรม 

 Inner Shadow  สร้างเงาด้านในวัตถุ Object, Stroke, Fill, และ Text ด้านในกรอบเฟรม 

 Outer Glow  สร้างรัศมีของแสดงบริเวณกรอบนอกของวัตถุ 

 Inner Glow  สร้างรัศมีของแสดงบริเวณกรอบในของวัตถุ 

 Bevel and Emboss สร้างมุมเหลี่ยมและลายนูนให้กับวัตถุ 

 Satin   สร้างเงาอย่างหยาบด้านในวัตถุ 

 Basic Feather  ไล่เฉดสีให้ค่อยๆ อ่อนลง โดยบริเวณมุมของวัตถุจะเป็นมุมโค้ง 

 Directional Feather   ไล่เฉดสีให้ค่อยๆ อ่อนลง โดยบริเวณมุมของวัตถุ จะเป็นมุมเหลี่ยม 
 Gradient Feather  ไล่เฉดสีให้ค่อยๆ อ่อนลงทั้งวัตถุ 

5. รูปแบบของกรอบภาพที่อยู่ในพาเนล Text Wrap หมายถึงอะไรบ้าง 

 

No text wrap   ไม่มีกรอบภาพ ข้อความไหลปกติ 

 

 



 

 

 

ตอนที ่2 จงทำเครื่องหมาย  ล้อมรอบตัวเลือกท่ีถูกต้องที่สุด 

 

1. จงเรียงลำดับขั้นตอนที่ถูกต้องของการเลื่อนภาพในเฟรมให้อยู่ในตำแหน่งที่เหมาะสม 

1. ปล่อยเมาส์ภาพในเฟรมจะแสดงอยู่ในตำแหน่งที่ต้องการ 

2. คลิกเลือก  Position Tool 

3. คลิกเมาส์ค้างไว้ที่ภาพ ตัวชี้เมาส์จะเปลี่ยนเป็น  จากนั้นเลื่อนภาพให้อยู่ในตำแหน่งที่ต้องการ 

ก. 3 2 1     ข. 1 2 3 

ค. 1 3 2    ง. 2 3 1 

2. รูปแบบการแสดงภาพกราฟิก ลายเส้น ที่มีความละเอียดสูง หมายถึงข้อใด 

ก. Currently    ข. High Quality 

ค. Fast     ง. Typical 

 

3. Ellipse Frame Tool เป็นเครื่องมือที่ใช้สร้างเฟรมในรูปแบบใด 

ก. เฟรมรูปสี่เหลี่ยม   ข. เฟรมรูปวงกลม 

ค. เฟรมรูปสามเหลี่ยม   ง. เฟรมรูปหลายเหลี่ยม 

 

Wrap around bounding box  ข้อความจะเว้นช่องเป็นกรอบภาพส่ีเหลี่ยม 

Wrap around object shape   ข้อความจะเว้นช่องเป็นรูปทรงรอบกรอบภาพ 

Jump object      ข้อความไหลแบบกระโดดข้ามรูปภาพและไหลต่อไป 

Jump to next column  ข้อความไหลเฉพาะด้านบนก่อนถึงภาพ และข้อความท่ี 

    เหลือจะไหลต่อเป็นวัตถใุหม่ ในต าแหน่งท่ีก าหนดได้เอง 
 



4. Rectangle Frame Tool เป็นเครื่องมือที่ใช้สร้างเฟรมในรูปแบบใด 

ก. เฟรมรูปสี่เหลี่ยม   ข. เฟรมรูปวงกลม 

ค. เฟรมรูปสามเหลี่ยม   ง. เฟรมรูปหลายเหลี่ยม 

 

5. ข้อใดต่อไปนี้ไม่เกี่ยวข้องกับขั้นตอนการใส่รูปภาพลงในเฟรม 

ก. เลือกคำสั่ง Edit->Paste  

ข. คลิกเลือกคำสั่ง Edit->Cut  

ค. คลิกเลือกเฟรมที่ต้องการใส่รูปภาพ  

ง. คลิกเลือกรูปภาพที่ต้องการบรรจุลงในเฟรม 

 

จงใช้คำตอบต่อไปนี้ตอบคำถามข้อ 6 - 8 

ก. Both Right & Left Sides  

ข. Right Side 

ค. Side Away from Spine 

ง. Largest Area 

6. กำหนดการไหลของข้อความทางด้านขวา หมายถึงข้อใด ตอบ ข้อ ข. 

7. กำหนดการไหลของข้อความด้านที่มีหยักน้อย หมายถึงข้อใด ตอบ ข้อ ค. 
8. กำหนดการไหลของข้อความด้านที่มีพ้ืนที่มากกกว่า หมายถึงข้อใด ตอบ ข้อ ง. 

9. Directional Feather หมายถึงข้อใด 

ก. สร้างรัศมีของแสดงบริเวณกรอบในของวัตถุ 

ข. สร้างเงาอย่างหยาบด้านในวัตถุ 

ค. ไล่เฉดสีให้ค่อยๆ อ่อนลงทั้งวัตถุ 

ง. ไล่เฉดสีให้ค่อยๆ อ่อนลง โดยบริเวณมุมของวัตถุ จะเป็นมุมเหลี่ยม 

 



10. Outer Glow หมายถึงข้อใด 

ก. สร้างรัศมีของแสดงบริเวณกรอบนอกของวัตถุ  

ข. สร้างมุมเหลี่ยมและลายนูนให้กับวัตถุ  

ค. ไล่เฉดสีให้ค่อยๆ อ่อนลง โดยบริเวณมุมของวัตถุจะเป็นมุมโค้ง  

ง. สร้างเงาอย่างหยาบด้านในวัตถุ 
 
 

 

 

 

 

 

 

 


